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About the Release Notes
The Release Notes are a comprehensive user guide for the latest release of Salesforce. Unlike a traditional release notes document
that includes only a simple list of enhancements, the Salesforce Release Notes give you everything you need to get up and
running with the new features and enhancements in the latest release.

What's Included in the Release Notes

For every new major enhancement, the Release Notes provide:

• A brief, high-level description of the functionality
• Implementation tips to help you get started with setup and administration
• Best practice tips to help you maximize the benefit of the functionality
• Complete end-to-end instructions on how to set up and use the functionality

Beyond the major new features, the Additional Enhancements sections include a list and brief description of every other
enhancement or functional change included in the latest release—everything from new user permissions, to workflow
enhancements, to updated browser support, to Setup menu changes.

Let the Release Notes be your guide to success with the latest release from salesforce.com!

Summary of Spring '09 Features and Impact on Salesforce Users
Spring '09 includes features that will immediately impact all Salesforce users when the release occurs. You may want to
communicate these changes to the users in your organization before the release so that they are prepared for any changes that
might affect them. Other features require direct action by a Salesforce administrator before your users can benefit from the
new functionality.

The following table summarizes the Spring '09 features and whether they will have an immediate impact on users:

Contact salesforce.com
to enable this feature.

Not automatically
visible. Feature is
enabled but requires
some setup or is only
available to
administrators.

Automatically visible
to all users. No setup
required.

Feature

Salesforce to Salesforce Enhancements

Partner Portal Enhancements

Content Delivery—Limited Release

Presentation Assembly

Content Packs

Personal Workspaces in Salesforce CRM Content
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Contact salesforce.com
to enable this feature.

Not automatically
visible. Feature is
enabled but requires
some setup or is only
available to
administrators.

Automatically visible
to all users. No setup
required.

Feature

Inline Content Views in Salesforce CRM Content

Simplified Tab Set in Salesforce CRM Content

Standard Workspace Permissions in Salesforce
CRM Content

Campaign Enhancements

Email-to-Case as a Service

Customer Portal Enhancements

Global Business Hours for Holidays

Opportunity Genius: Finding Similar
Opportunities

For existing
organizations, this

Automatically enabled
for all new
organizations.

New Opportunity Save Behavior

feature will be
introduced in a phased
approach.

Device Assignment Security Control

Mobile Asset Management

Multi-Relationship Support

One-Click Installation for BlackBerry

Actions Toolbar for iPhone

Log-a-Call Popup for iPhone

Change Owner for iPhone

Standard Views for iPhone

Visualforce Mobile and Mobile Web Tabs for
iPhone
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Contact salesforce.com
to enable this feature.

Not automatically
visible. Feature is
enabled but requires
some setup or is only
available to
administrators.

Automatically visible
to all users. No setup
required.

Feature

Dashboards for iPhone

Related Lists on Detail Pages for Windows
Mobile

Related Records Search for Windows Mobile

Opportunity Contact Roles for Windows Mobile

Automatic Purging of Searched Records for
Windows Mobile

New Time Picker for Events

Show Closed in Case Status Field Setting

"Modify All Data" Permission Now Includes
"Delete" Permission on Cases

Replace Case Team Roles

Report on Case Teams

Enhanced User Interface for Case Teams

CTI Support for Firefox

Case Auto-Response Rule Enhancements

Email-to-Case Enhanced Email Address
Matching

Search the Full Text of a Document in the
Documents Tab

Suggested Duplicates for Ideas

Enhanced Page Layout Editor

Delegated Data Administration

Analytics Enhancements

4

About the Release Notes



Contact salesforce.com
to enable this feature.

Not automatically
visible. Feature is
enabled but requires
some setup or is only
available to
administrators.

Automatically visible
to all users. No setup
required.

Feature

Critical Updates Console

Workflow Rule and Roll-Up Summary Field
Evaluations Update

Force.com Sites Enhancements

Visualforce Enhancements

Force.com Apex Code Enhancements

Force.com Web Services API Enhancements

Force.com Office Toolkit Enhancements

Force.com Development as a Service

Browser Support: Mozilla Firefox 3.0

Package API and Apex Access Setting
Enhancements

Users Appear in Recent Items Lists

Email Client Enhancements

Offline Enhancements

Data Loader Field Truncation

Email Deliverability and Email Log Access

Additional Language Support for Spell Checker

Indonesian Language Support

Salesforce.com Style Guide and Online Help CSS
Publicly Available

Forcing Relogin After Login-As-User Session
Ended

Download Zipped Login History
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Contact salesforce.com
to enable this feature.

Not automatically
visible. Feature is
enabled but requires
some setup or is only
available to
administrators.

Automatically visible
to all users. No setup
required.

Feature

Workflow and Approval Processes in Professional
Edition

Cross-Object Workflow for Custom Objects

TEXT() Function Support for Picklists in
Validation Rules

Locale Rule Support in the UPPER() and
LOWER() Functions for all Formulas
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SALESFORCE APPLICATIONS

Salesforce to Salesforce Enhancements

Available in: All Editions

Salesforce to Salesforce includes the following enhancements in Spring '09:

Note: Salesforce to Salesforce Spring '09 enhancements will be available at the end of February, 2009.

Sharing with Multiple Partners

You can now share records with multiple Salesforce to Salesforce connections. Previously, only the first connection to
accept a shared record would have access to that record. Now, multiple connections can accept and have access to the
same shared record. The Sent Connection Name field, while still visible, is no longer populated and should no longer
be used with Apex and workflow rules.

Sharing Products with Partners

You can now share product records with Salesforce to Salesforce connections.

Sharing Opportunity Products with Partners

You can now share opportunity products with Salesforce to Salesforce connections.

Connection Invitation Templates

To simplify the process of publishing to Salesforce to Salesforce connections, new connection templates allow you to
define objects and fields that can be published. Connection templates can then be assigned to one or more connections.

Sharing Formula and Roll-up Summary Fields

You can map formula fields to fields of the same data type; for example, a formula field that has a number data type can
be mapped to a field with a number data type. If a formula field is a text data type, it can be mapped to a text field with
a length of 80 or more characters. Conversely, fields cannot be mapped to formula fields; for example, a formula field
with a currency data type can be mapped to a currency field, but a currency field cannot be mapped to a formula field.
Auto-number and system audit fields are not supported.

You can map roll-up summary fields to currency fields with the same currency type. For example, a roll-up summary
with the currency type U.S. Dollar can be mapped to a currency field that uses the U.S. Dollar. Auto-number and system
audit fields are not supported.

Salesforce to Salesforce API

Using the new PartnerNetworkRecordConnection API object, you can share records with your Salesforce to Salesforce
connections using the API. For more information, see PartnerNetworkRecordConnection on page 96.
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About Salesforce to Salesforce Enhancements

Sharing A Record with Connections

You can share lead, opportunity, account, contact, task, product, opportunity product, and custom object records with one or
more business partners with whom you have a connection.

Note: You can only forward records that you or your subordinates own; System Administrators can forward all records.

To forward a single record and its related records to one or more connections:

1. Select the record's detail page.
2. In the External Sharing related list, click the forward button. For example, on an opportunity, click Forward this

Opportunity.
3. Select the connection(s) that you want to forward the record to in the Available Connections list.
4. Click the Add arrow ( ) to move the connection(s) to the Selected Connections list.
5. Optionally select Send Notification Email (new invitees only) to send an email notifying the connection's representative

that you have forwarded the record to them. Only new recipients of the record will receive the notification email. Connections
that you previously forwarded the record to will not receive another email.

6. Optionally select the checkboxes next to related record types you want to forward with the master record.
7. Click Save.

The record and any related records you selected are forwarded to the connections you specified. For information about sharing
related records separately, see "Forwarding Related Records to a Connection" in the Salesforce online help.

Sharing Multiple Records with Connections

To forward multiple records to one or more connections:

1. Select the tab of the record type you want to forward. For example, to forward opportunity records, select the Opportunities
tab.

2. Select a list view from the View drop-down list, then click Go!.
3. In the list view, select the checkboxes next to the records you want to forward. To select all records, select the checkbox

in the column header.
4. Click Forward to Connections.
5. Select the connection(s) that you want to forward the record to in the Available Connections list.
6. Click the Add arrow ( ) to move the connection(s) to the Selected Connections list.
7. Optionally select Send Notification Email (new invitees only) to send an email notifying the connection's representative

that you have forwarded the record to them. Only new recipients of the record will receive the notification email. Connections
that you previously forwarded the record to will not receive another email.

8. Optionally select the checkboxes next to the related record types you want to forward with the master records.
9. Click Save.

The records and any related records you selected are forwarded to the connections you specified.

Sharing Opportunity Products with Connections

An opportunity product is related to both opportunity and product records, and therefore, can only be shared as a child record
of a shared opportunity, provided the associated product is also shared.
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If all of the following criteria are met, opportunity products are automatically shared with connections; opportunity products
cannot be shared separately.

• The Opportunity Product object type must be published to your connection, and your connection must subscribed to the
object.

• The opportunity and the product associated with the opportunity product must be shared with your connection:

- You can share the opportunity from the External Sharing related list on the opportunity. You must select the Opportunity
Product checkbox in the Forward existing related records section.

- You can share the product from the Products related list on the opportunity using the Manage Connections link.

• In the connection's organization, the opportunity must be associated with an active price book during acceptance.
• In the connection's organization, the product must be associated with the same active price book as the opportunity.
• In the connection's organization, the product must be active.
• In both organizations, the opportunity currency must be the same.

When sharing opportunity products, consider the following additional rules:

• If quantity or revenue schedules are enabled in the connection's organization, Quantity and Sales Price fields will not be
updated in the connection's organization.

• If the price book associated to the opportunity product is changed or deleted in one organization, the opportunity product
will no longer be shared.

• If the opportunity is no longer shared, the opportunity product will no longer be shared.

What are Connection Templates?

Connection templates allow you to define objects and fields that can be published to connections. Connection templates can
be assigned to one or more connections, making the process of publishing fast and easy. From the Connections tab, click the
Templates subtab to view, create, and edit connection templates.

When a connection template is applied to a connection, the object and field rules are applied to that connection.

The following rules apply to connection templates:

• Objects and fields that are not already published but are published in the connection template are published.
• Objects and fields that have the same publish or unpublish status as the template are unchanged.
• Objects and fields that are already published but are not published in the connection template are unpublished.

Creating and Editing Connection Templates

Connection templates allow you to define object and field publishing rules that can be applied to one or more connections.

To create a connection template:

1. Select the Connections tab.
2. Select the Templates subtab.
3. Click New.
4. Type a name and an optional description.
5. Select the Active checkbox if you want to be able to assign the template to connections.
6. Click Save to save the template, or click Save & Add Objects to add objects to the template.
7. If you clicked Save & Add Objects, select the checkboxes next to the objects you want to add, then click Save.

Note:  If you clicked Save, you can click Add/Remove Objects on the template detail page to add objects.

8. Click Edit next to an object you added to the Published Objects related list.
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9. Select the fields you want to publish for the object, then click Save.
10. Repeat steps 8 and 9 for each object you added to the Published Objects related list.

To edit a connection template, you can click Edit next to the template you want to edit on the Templates subtab. Alternatively,
you can click Edit on a template detail page. After you have made the necessary changes, click Save to save the template or
Save & Add Objects to add or remove objects.

To deactivate a connection template:

1. On the Templates subtab, click Edit next to the template you want to deactivate. Alternatively, click Edit on the template
detail page.

2. Deselect the Active checkbox.
3. Click Save.

Note:  Only active connection templates can be assigned to connections.

Assigning Connection Templates to Connections

You can assign connection templates to connections when inviting one or more new connections, or you can assign connection
templates to existing connections.

To assign a connection template when inviting one new connection:

1. Click the Connections tab.
2. Click New.
3. Enter a contact name or use the lookup icon to select a contact.

Important:  Make sure that the email address is valid; otherwise, your invitation may be sent to the wrong person.

4. Optionally, select a related account.

Note: The account associated with the connection can be changed after the invitation is sent.

5. Choose a user to manage the connection.
6. Optionally choose a template to apply to the connection.
7. Click Save & Send Invite.

To assign a connection template when inviting multiple new connections:

1. Click the Contacts tab.
2. Select a standard or custom list view, then click Go!.
3. In the list view, select the checkboxes next to the contacts you want to invite. To select all contacts, select the checkbox in

the column header.

Important:  Make sure that the email addresses are valid; otherwise, your invitations may be sent to the wrong
people.

4. Click Invite to Connect.
5. Choose a user to manage the connection.
6. Optionally choose a template to apply to the connection.
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7. Click Save & Send Invite.

To assign a connection template to an existing connection:

1. Select the Connections tab.
2. Select the Connections subtab.
3. Click the name of the connection you want to assign the template to.
4. Click Edit.
5. In the Template field, type the name of the template or click the lookup icon to search for a template.
6. Click Save.

Partner Portal Enhancements

Available in: Enterprise and Unlimited Editions

The Partner Portal includes the following enhancements in Spring '09:

Cases for Partners

You can now enable users to access the Cases tab in the Partner Portal.

Email for Partners

You can now enable partner users to send email from the Partner Portal.

About Partner Portal Enhancements

Enabling Cases for Partner Users

When you enable cases in the Partner Portal, you can assign cases to partner users directly or using assignment or escalation
rules. Partner users can edit cases, create new cases, add case comments, reassign cases, find case solutions, and create case
teams. Partner users cannot edit case comments or associate assets with cases.

Note: The Cases tab is only available to partner users with Gold Partner or Partner licenses.

To enable cases in the Partner Portal:

1. Add the Cases tab to the list of available tabs in the Partner Portal.
2. In the partner user profile, verify that the cases standard tab setting is set to Default On.
3. In the partner user profile, enable the "Read," "Create," and "Edit" standard object permissions for cases.

For information about assigning cases to partners, see "Assigning Cases to Partner Users" in the Salesforce online help.

After enabling cases in the Partner Portal, consider the following tips:

• Specify a case creation template in Setup ➤ Cases ➤ Support Settings to allow partner users to send a notification email
to new contacts assigned to cases.

• Configure case team roles in Setup ➤ Customize ➤ Cases ➤ Case Teams ➤ Case Team Roles to allow your partners
to add case team members.
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Assigning Cases to Partner Users

Before you can assign cases to Partner Portal users, you must configure cases for partner users.

To assign cases to partner users:

1. Select a case from the Cases tab or a Cases related list.
2. On a case detail page, click [Change] next to the Case Owner field.
3. Select Partner User from the Owner drop-down list and enter the name of the partner user, or click the lookup icon ( )

to search for a partner user.
4. Optionally, select the Send Notification Email checkbox to send an email to the new owner.
5. Click Save.

The partner user will be able to view and edit the case from the Partner Portal.

You can also create case assignment and escalation rules that automatically assign cases to partner users or queues based on
certain properties of those cases. For more information, see "Setting Up Assignment Rules" in the Salesforce online help and
"Setting Up Escalation Rules" in the Salesforce online help.

For information about how your partner users can create and edit cases in the Partner Portal, download the Partner Portal
User Help.

Enabling Email for Partner Users

Enabling email in the Partner Portal allows partner users to send email from Activity History related lists in the Partner Portal.
For example, a partner user can click the Send An Email button in the Activity History related list on a lead to send an email
to the lead and log the email in the related list.

To enable email for partner users:

1. Click Setup ➤ Manage Users ➤ Profiles.
2. Click Edit next to a partner user profile.
3. Select the Send Email checkbox.
4. Click Save.

Partner users assigned to that profile will be able to send email from the Partner Portal. To allow partner users to use email
templates, you must make the templates available to them. For more information, see Managing Email Templates.

For more information about user profiles, see "Creating and Editing Profiles" in the Salesforce online help.

For information about how your partner users can use email in the Partner Portal, download the Partner Portal User Help.

Content Delivery—Limited Release

Available in: All Editions

Note:  Content Delivery is available as a limited release only. Contact salesforce.com for more information.

A content delivery allows you to easily convert documents such as Microsoft® PowerPoint and Word files into an optimized
Web page for online viewing. Once you create your delivery, you can send its URL to any recipient—either inside or outside
Salesforce—and then track how often the content is viewed or downloaded. In addition to tracking, content deliveries provide
several benefits over sending files as attachments, such as giving you control over how long the delivery is available to viewers
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and whether a viewer can download a file or see it online only. Content deliveries can be created from the Content Deliveries
related list on leads, accounts, contacts, opportunities, cases, campaigns, or custom objects. Salesforce CRM Content users
can also create a content delivery from the content details page or the Related Content related list.

Implementation Tips

• Content deliveries can include all file types for download; however, the preview player launched by the content-delivery
URL supports only PowerPoint, Word, Excel, and Adobe® PDF files for online viewing.

• The preview player launched by the content-delivery URL requires Adobe Flash. If the recipient does not have Flash
installed, they are offered the option to download it.

• Customer Portal and Partner Portal users cannot create content deliveries.
• Only the creator of a content delivery can delete the delivery record or edit details such as the expiration date.
• To delete a Salesforce CRM Content file that is associated with a content delivery, first delete the content delivery.
• Each time a content delivery's URL is clicked, Salesforce records the click as one view and distinguishes between internal

and external views. An internal view is a view by a Salesforce user, for example, clicking the delivery URL on the delivery
detail page or the View option on the Content Deliveries related list. The Content Deliveries related list provides a count
of all views for each delivery. Open the delivery details page to see information about a specific view.

• Uploading a file consumes file storage. For more information, see "Monitoring Resources" in the Salesforce online help.
• To protect against denial-of-service attacks, the total number of views allowed within a twenty-four-hour period is limited.

Best Practices

• After creating a content delivery, always preview it before sending the URL to your recipients; ensures that the formatting
in the original file displays properly in the online version. For example, colors and non-standard fonts may not display
properly in the preview player. If you are not happy with the quality of the online version, click Previous and choose to
make your content available in its original file format or as a PDF file only. Your recipients will be able to download the
file, and you can track whether the file was downloaded on the delivery detail page.

• Animation and timings in PowerPoint files are not supported in the content delivery's online version. Hyperlinks in all
file types are also unsupported.

• If you are a Salesforce CRM Content user and want recipients of your content delivery to always see the latest version of
a file rather than the version available on the delivery-creation date, open the delivery detail page and click Edit. Select
the Content Delivery Opens Latest Version checkbox.

• If you select Notify Me of First View or Download, you will receive an email when the content delivery is viewed
for the first time.

About Content Deliveries

Setting up Content Deliveries

User Permissions Needed

"Customize Application"To enable content deliveries:

To enable content deliveries for your organization, click Setup ➤ Customize ➤ Content Deliveries and select the Enable
content deliveries checkbox. Also, add the Content Deliveries related list to your page layouts for leads, accounts,
contacts, opportunities, cases, campaigns, or custom objects. For more information about adding a related list to a page layout,
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see "Customizing Page Layouts" in the Salesforce online help. For detailed instructions on creating a content delivery, see
"Creating Content Deliveries" in the Salesforce online help.

Creating Content Deliveries

To create a new content delivery:

1. From the Content Deliveries related list, Related Content related list, or the content details page, click Deliver Content.
2. Upload a file or, if you are a Salesforce CRM Content user, search for the content in your workspaces that you want to

deliver.
3. Optionally, modify the Delivery Name field. This is the name that identifies your content delivery in Salesforce. We

recommend using a name that will make the delivery easily distinguishable from other deliveries on the same record. The
default delivery name includes the file name and today’s date.

4. Select the delivery methods that determine how your content can be viewed. The options that appear depend on the file
format you uploaded.

• Choose Allow View in the Browser to create an online version of the file that recipients can view in their browser.
• Choose Allow download as [file type] file to allow the recipient of your content delivery to view the content

in its original format. For example, if you uploaded a Microsoft® Word file, this field will be Allow download as

.doc file.
• Choose Allow download as a .pdf file to create a .pdf version of the file. This option is only available for

Microsoft® PowerPoint, Word, and Excel files.

5. Select Notify Me of First View or Download if you want to receive an email the first time your recipient clicks
the content-delivery URL.

6. If the content you are delivering is time-sensitive, select the Remove access to content on checkbox and enter an
expiration date. By default, the expiration date is 90 days from the current date. After creating your content delivery, you
can change the expiration date at any time on the delivery detail page.

7. Optionally, use the lookup to associate your content delivery with a Salesforce record. The record you were viewing when
you clicked Deliver Content is selected by default.

8. Click Save & Next. Your delivery will usually be ready within a few moments, but you can click Notify Me to exit the
content delivery wizard and be notified via email when your content delivery is ready.

9. If you did not exit the content delivery wizard, click Preview to verify that you are satisfied with the delivery.

Important:  Formatting in the original file may not display correctly in the online version. If you chose View
content in the browser, preview your content delivery before sending its URL to your recipients. If you are
not happy with the quality of the online version, click Previous and choose to make your content available in its
original file format or a PDF only.

10. Copy and paste the delivery URL into an email or instant message for delivery. The URL is available on the delivery detail
page. For more information, see "Viewing and Editing Content Deliveries" in the Salesforce online help.
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Viewing and Editing Content Deliveries

User Permissions Needed

Access to the associated content details page in Salesforce
CRM Content OR

Access to the record associated with the content delivery

To view the delivery detail page:

Owner of the record OR

"Modify all Data"

To edit, expire, or delete a content delivery:

On the Content Deliveries related list or the Content Deliveries list page, click the name of a content delivery to open the
detail page.

Viewing Content Delivery Details

The delivery detail page provides all the information associated with a content delivery, including the URL required to
access the content delivery, the number of times the delivery has been viewed, and the delivery settings. For a description
of each field, see "Content Delivery Fields" in the Salesforce online help.

Editing Content Delivery Details

Click Expire Now to immediately remove access to the content delivery. Click Edit to modify details such as the delivery
methods, expiration date, or the record the delivery is associated with. For a description of each field, see "Content
Delivery Fields" in the Salesforce online help.

Deleting Content Deliveries

Click Delete to remove access to the content delivery and delete the delivery record from Salesforce. Salesforce CRM
Content users cannot delete files that are associated with a content delivery until the content delivery is deleted.

Tracking Content Deliveries

Each time a content delivery's URL is opened, Salesforce records the event as a view. The Views related list on the
content delivery detail page lists every view associated with the delivery. Information about the view includes the date
and time, whether the view was by an internal (Salesforce) user, and whether the view included a download. If the content
delivery provided the ability to download the file in its original file format or as a PDF file, the File Downloaded flag
indicates that a download occurred, but you cannot distinguish between file types.

Content Delivery Fields

DescriptionField

If checked, the content delivery can be viewed online in a
custom Web page.

Allow View in the Browser

If checked, the content delivery converts Microsoft® Word,
Excel, and PowerPoint files into PDF files and gives the

Allow Download as PDF

recipient the option of downloading the PDF. If the file you
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DescriptionField

uploaded was not a PDF, Word, Excel, or PowerPoint file,
this option does not appear in the create-delivery wizard.

If checked, the content delivery allows recipients to download
the original file. In the create-delivery wizard, this field is

Allow Download in Original Format

called Allow download as a[file type] file where
[file type] is the original file's file type, such as .ppt, .pdf.,
.doc, and .jpeg.

For Salesforce CRM Content files, the user who published
the file. (Read only)

Author

The name assigned to the content delivery. By default, the
Content Delivery Name includes the file name and the
creation date.

Content Delivery Name

For Salesforce CRM Content files, this flag indicates that the
recipient of a content delivery sees the most current version

Content Delivery Opens Latest Version

of a file. For example, if a file is updated between the
delivery-creation date and today's date, a recipient who views
the delivery today sees the newest version.

A flag that indicates whether access to the content delivery
will expire on the expiration date. In the create-delivery wizard,

Content Delivery Expires

this flag corresponds to the checkbox next to the Remove
access to content on field.

The user who created the content delivery, including creation
date and time. (Read only)

Created By

The date and time on which the content delivery was created.
(Read only)

Created Date

For Salesforce CRM Content files, the description provided
when the file was published. (Read only)

Description

The date on which the content delivery can no longer be
viewed. In the create-delivery wizard, this is the date entered
in the Remove access to content on field.

Expiration Date

A flag that indicates whether a file in the content delivery was
downloaded. For example, if a content delivery includes

File Downloaded

options to view the content in the browser, download the
content in its original file format, and download the content
as a PDF file, this flag is checked if the recipient downloads
the original file or the PDF file. (Read only)

A flag that indicates whether a Salesforce user viewed the
content delivery. A view is considered internal if the user opens

Internal View

the delivery URL from within Salesforce, for example by
clicking View on the Content Deliveries related list or clicking
the delivery URL on the delivery detail page. If the user copies
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DescriptionField

the URL and pastes it into his or her browser, the view is
considered external. (Read only)

The user who last modified the content delivery, including
modification date and time. (Read only)

Last Modified By

The date and time on which the content delivery was last
modified. (Read only)

Last Modified Date

The date and time on which the content delivery was last
viewed. A view is one click of the content-delivery URL. (Read
only)

Last Viewed

If checked, the user who created the content delivery receives
an email notification the first time the content delivery URL
is clicked.

Notify Me of First View or Download

The user who owns the content delivery. (Read only)Owner Name

The record that the content delivery is associated with, such
as an account, opportunity, or custom object. Users with
sharing access to the record can click it to view more details.

Related To

For Salesforce CRM Content files, the title of the file included
in the content delivery. (Read only)

Title

Total number of views for the content delivery, including
internal and external. (Read only)

View Count

Salesforce CRM Content Enhancements

Available in: Professional, Enterprise, and Unlimited Editions

Spring '09 introduces several new features and enhancements for Salesforce CRM Content. For information about the content
delivery feature that is available to both Salesforce CRM Content users and non-Salesforce CRM Content users, see Content
Delivery—Limited Release on page 12.

Salesforce CRM Content enhancements in Spring '09 include:

Presentation Assembly

You can create a custom Microsoft® PowerPoint presentation by searching for and previewing all slides in your workspaces,
then easily assembling them in whatever sequence you choose using a simple drag-and-drop assembly tool.

Content Packs

A content pack is a collection of related documents or files that are stored as a group in Salesforce CRM Content. Content
packs make it easy to store, find, and send related content.
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Personal Workspaces

You can now store private documents and files in a personal workspace, which allows you to reduce the clutter on your
desktop while using content-management benefits such as document search and version control. Files can remain in
your personal workspace indefinitely or you can publish them to a shared workspace at any time.

Simplified Tab Set

To help you maximize your available space in Salesforce, the Salesforce CRM Content application now has three tabs
instead of four. The functionality previously available on the Contribute tab has been moved to the Workspaces tab.

Inline Content Views

Previously in Salesforce CRM Content you could only preview the first four pages of PowerPoint files. In Spring '09,
you can view PowerPoint, Word, Excel, and PDF files in their entirety.

Standard Workspace Permissions

Previously, new organizations had to create one or more workspace permissions in Salesforce CRM Content. In Spring
'09, Salesforce CRM Content includes three workspace permissions that provide the different levels of workspace access
required for most organizations.

Sandbox Support

Enterprise Edition and Unlimited Edition customers can now use Salesforce CRM Content in the sandbox.

About Salesforce CRM Content Enhancements

Presentation Assembly

Salesforce CRM Content makes it easier than ever to reuse content and quickly tailor it to the needs of a particular prospect
or customer. With the presentation feature, you can create a custom Microsoft® PowerPoint presentation by searching for and
previewing all slides in your workspaces, then easily assembling them in whatever sequence you choose using a simple
drag-and-drop assembly tool.

When you publish a PowerPoint file, Salesforce CRM Content not only uploads the entire file to your workspace but also
extracts the individual slides so they are available when you assemble or modify a presentation. Salesforce CRM Content can
perform a full-text search of each slide and return only slides applicable to your purpose, or you can browse all slides published
into your workspaces. The assembly tool allows you to create or modify the custom presentation by dragging and dropping
individual slides. You can publish the presentation to a public workspace or keep it in your personal content area.

To work with presentations:

1. Depending on whether you want to create, copy, or modify a presentation, use one of the following options:

• To create a new presentation, click the Workspaces tab and then choose Create New ➤ Presentation.
• To create a new presentation by copying an existing presentation, on the content details page click Copy & Customize.
• To modify a presentation and save it as a new version, on the content details page click Edit ➤ Modify Presentation.

2. Click Search presentations to display all the PowerPoint files in your workspaces or click Search slides to display all the
individual slides in your workspaces. To refine your results, select a specific workspace to search or enter a search term in
the text box before clicking either button.

3. Drag the desired files or slides from the search results into the assembly section in the lower half of the window. The
following options help you assemble your presentation:
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• In search results, click a file or slide to preview it in the lower half of the window. Choose Add to presentation or Hide
preview as needed.

• Click Clear at any time to revert your changes; click Cancel to return to your starting point.
• In search results, hover over a presentation and click the slides icon ( ) to view all the slides in the presentation.
• In search results, hover over a slide and click the presentation icon ( ) to view all the presentations that use that slide.
• In the assembly section, hover over a document and click the garbage can icon ( ) to remove that document from the

presentation you are assembling.

4. When you are done assembling your presentation, click Save, assign or change the presentation's name.
5. In the Save or Publish dialog:

a. Select a workspace. If you do not want the presentation to be visible to other users in your organization, for example
if your work is still in progress, choose Save in my personal workspace.

b. Optionally, add or modify the presentation's description.
c. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you

do not choose a language, Salesforce CRM Content associates your content with your personal language setting. If
users restrict their content searches to a particular language, only content associated with that language is displayed in
the search result set.

d. If you are modifying the presentation, complete the Reason for Change field.
e. To publish the content on behalf of another author, choose that author from the drop-down list.
f. Tag your content. Your tagging permission depends on the tagging rule assigned to the workspace:

• If the workspace does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter
tags in the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent
Tags list and the Popular Tags section on the Workspaces tab. The My Recent Tags list on the Contribute window
shows the 20 tags you have used most recently. Click a tag to add it to the Tags field automatically.

• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When
you select a tag it turns green.

g. If multiple content types are available, choose one from the drop-down list.The content type determines which custom
fields appear for you to categorize and define your content.

h. Click Publish. You can then view the content details page, return to the Workspaces tab, or publish another file.

Content Packs

A content pack is a collection of related documents or files that are stored as a group in Salesforce CRM Content. For example,
you may want to create a content pack with a product list, price quote, and contract to send to a particular customer. Any file
in Salesforce CRM Content can be added to a content pack, from traditional business documents such as Microsoft® PowerPoint
presentations and Adobe® PDF files, to audio files, video files, and Google docs. Using email or instant messaging, you can
distribute the content pack to colleagues in your organization or leads and contacts outside your organization. The recipient
of a content delivery can click a single URL to open a preview player with which he or she can preview and download the
content. You can then view tracking information to see how often the content pack was viewed and which documents were
downloaded. For information about delivering content packs, see "Setting up Content Deliveries" in the Salesforce online
help.
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Note:  Content packs support all files types; however, the preview player launched by the content-delivery URL displays
only PowerPoint, Word, Excel, and PDF files.

To work with content packs:

1. Depending on whether you want to create, customize, or modify a content pack, use one of the following options:

• To create a new content pack, click the Workspaces tab and then choose Create New ➤ Content Pack.
• To create a new content pack by copying an existing pack and adding, removing, or reordering files, open the content

details page for the pack and click Copy & Customize.
• To update a content pack and publish a new version, open the content details page for the pack and click Edit ➤

Modify Content Pack.

2. Click Search files to display all the content in your workspaces. To refine your results, select a specific workspace to search
or enter a search term in the text box.

In addition to files and documents, search results also list content packs.

3. Drag the desired content from the search results into the assembly section in the lower half of the window. The following
options help you assemble your content pack:

• In the search results, click a document to preview it in the lower half of the window. Choose Add to Content Pack or
Hide preview as needed.

• In the search results, hover over a document and click the folder icon ( ) to view the content packs that use the
document.

• In the search results, hover over a content pack and click the folder icon ( ) to view all the documents in the pack.
• In the assembly section, hover over a document and click the garbage can icon ( ) to remove that document from the

pack you are assembling.
• Click Clear at any time to revert your changes; click Cancel to return to the Workspaces tab.

Note: The maximum number of files that can be included in a content pack is 50.

4. When you are done assembling or modifying your content pack, click Save and assign or change the content pack's name.
5. In the Save and Publish dialog:

a. Select a workspace. If you do not want the content pack to be visible to other users in your organization, for example
if your work is still in progress, choose Save in my personal workspace.

b. Optionally, add or modify the content pack's description.
c. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you

do not choose a language, Salesforce CRM Content associates your content with your personal language setting. If
users restrict their content searches to a particular language, only content associated with that language is displayed in
the search result set.

d. If you are modifying the content pack, complete the Reason for Change field.
e. To publish the content on behalf of another author, choose that author from the drop-down list.
f. Tag your content. Your tagging permission depends on the tagging rule assigned to the workspace:

• If the workspace does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter
tags in the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent
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Tags list and the Popular Tags section on the Workspaces tab. The My Recent Tags list on the Contribute window
shows the 20 tags you have used most recently. Click a tag to add it to the Tags field automatically.

• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When
you select a tag it turns green.

g. If multiple content types are available, choose one from the drop-down list.The content type determines which custom
fields appear for you to categorize and define your content.

h. Click Publish. You can then view the content details page, return to the Workspaces tab, or publish another file.

Personal Workspaces in Salesforce CRM Content

You can now store private documents and files in a personal workspace, which allows you to reduce the clutter on your desktop
while using content-management benefits such as document search and version control. With a personal workspace you can:

• Ensure a secure location for your in-progress documents.
• Publish your content to a public workspace when you are ready.
• Use the content delivery feature to send content to leads and contacts outside Salesforce, without exposing the content to

a public workspace in your organization.

To view your personal workspace, click the Workspaces tab and then My Personal Content.

Simplified Tab Set in Salesforce CRM Content

To help you maximize your available space in Salesforce, the Salesforce CRM Content application now has three tabs instead
of four. The functionality previously available on the Contribute tab has been moved to the Workspaces tab. New customers
that sign up with the Spring '09 release will see the Workspaces, Content, and Subscriptions tabs in Salesforce CRM Content.
Existing customers will still see the Contribute tab, but as of Spring '09 the Contribute tab only contains a link to the Workspaces
tab. We recommend removing the Contribute tab from your tab set.

Inline Content Views in Salesforce CRM Content

Previously in Salesforce CRM Content you could only preview the first four pages of Microsoft® PowerPoint files. In Spring
'09, you can view PowerPoint, Word, Excel and PDF files in their entirety, making it quick and easy to determine if content
is relevant to you. To view a document, open its content details page.

Standard Workspace Permissions in Salesforce CRM Content

Previously, new organizations had to create one or more workspace permissions in Salesforce CRM Content. A workspace
permission is a group of privileges assigned to each Salesforce CRM Content workspace member that determines which tasks
a member can perform in a particular workspace. In Spring '09, Salesforce CRM Content includes three workspace permissions
that provide the different levels of workspace access required for most organizations: Workspace Administrator, Author, and
Viewer. Organizations that signed up for Salesforce CRM Content prior to Spring '09 do not receive the new workspace
permissions.
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Sandbox Support for Salesforce CRM Content

Enterprise Edition and Unlimited Edition customers can now use Salesforce CRM Content in all three types of sandboxes:
Configuration Only, Developer, or Full. For configuration-only sandboxes, 500 MB of file storage is provided. For developer
sandboxes, 10 MB of file storage is provided. Full sandboxes receive the same amount of file storage as the production
organization, and all content in the production organization is copied to the full sandbox. For more information about using
sandboxes, see the Salesforce online help.

Campaign Enhancements

Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

Campaigns include the following enhancements in Spring '09:

Campaign Members Related List

The new Campaign Members related list on a campaign detail page allows you to view, add, update, and remove campaign
members.

Manage Members Page

The new Manage Members page includes Add Members and Existing Members subtabs, from which you can easily
add, update, and remove campaign members.

Manage Members Button Enhancements

The Manage Members button on the campaign detail is now a drop-down button with additional options. The Manage
Members drop-down button, which also displays in the Campaign Members related list, allows you to access the new
Manage Members page.

Implementation Tips

• Use the Campaign Members related list to quickly segment your leads and contacts by geography, company size, title, or
any other criteria, and add them to a campaign. For example, if your campaign is targeted at CEOs, you could search for
all leads that have the title CEO and add them to your campaign.

• You can also easily update or remove individual or multiple existing campaign members. For example, if you have a campaign
that should not include CIOs but you already added several CIOs, you can search for all members that have the title CIO
and remove them from your campaign.

About Campaign Enhancements

Using the Campaign Members Related List

To view, add, edit, or remove campaign members directly from a campaign detail page, add the Campaign Members related
list to your campaign page layout.
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The Campaign Members related list displays five campaign members by default. To display more members, click the Show
more link. The Manage Members drop-down buttons in the Campaign Members related list and in the campaign detail
section let you search for leads and contacts and add them as campaign members, update or remove existing members, and
add and update campaign members using an import file.

Adding Campaign Members

Note:  Before using the Manage Members page, verify that you are using "a supported browser" in the Salesforce
online help.

To add campaign members from the Manage Members page:

1. From the campaign detail or the Campaign Members related list, click Manage Members ➤ Add Members - Search.
2. On the Add Members subtab, select the Leads or Contacts radio button to add leads or contacts, respectively.
3. Search for leads or contacts:

• You can specify search filters and click Go!
• Alternatively, you can select an existing view, such as all open leads, from the Use Existing View drop-down list. Your

results will display automatically. If you select an existing view, you can modify its criteria by adding or changing filters,
and clicking Go!.

Note: You cannot modify filter criteria if you selected a view that uses advanced options or that uses more than
five filters. Filter criteria will be reflected in your search results for these views, though not all filter criteria will
display.

4. Select the checkboxes next to the records you want to add. To select all records on the current page, select the checkbox
in the header row.

5. Select a status from the Add with Status drop-down list.

A confirmation message will display and you will see the members you added on the Existing Members subtab.

Consider the following tips when working with the members list:

• To hide the search filters, click Hide Search in the left corner above the search options on the Add Members subtab, or
click Hide Filters in the left corner above the filters on the Existing Members subtab.

• To clear the search filters, click Clear Filters under the filters.
• Navigate through the list results by clicking the first page icon (<<), Previous, Next, or the last page icon (>>) at the bottom

of the list.
• Jump to a specific page of results by entering a number in the text box in the lower right corner and then pressing Enter.
• Change the number of records displayed per page by clicking the record count indicator in the lower left corner of the list

and choosing a number. You can view 10, 25, 50, 100, or 200 records at a time. When you change this setting, you return
to the first page of list results. Changing your preference for the number of records displayed per page applies to all lists
in all Salesforce apps, not just the list currently displayed. In addition, if you change your preference to 200, a message
warns you of possible performance degradation.

• Change the width of a column by dragging the right side of the column heading with your mouse. Any changes you make
to column widths are specific to this list only, and the changes are retained when you next view the list.

• Click the Edit Columns link in the upper right corner of the list to add or remove columns.

Note: The latest Manage Members page is not available in accessibility mode. For help with managing members in
accessibility mode, see Mass Adding Contacts or Leads to a Campaign, Mass Updating the Status of Campaign
Members, or Mass Removing Contacts or Leads from a Campaign.
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Updating or Removing Campaign Members

Note:  Before using the Manage Members page, verify that you are using "a supported browser" in the Salesforce
online help.

To update the campaign member status or remove campaign members from the Manage Members page:

1. From the campaign detail or the Campaign Members related list, click Manage Members ➤ Edit Members - Search.
2. On the Existing Members subtab, optionally enter filter criteria to find existing members and click Go!.
3. Select the checkboxes next to the records you want to edit. To select all records on the current page, select the checkbox

in the header row.
4. To change the campaign member status, select a status from the Update Status drop-down list. To remove a member

from a campaign, click Remove.

A confirmation message will display.

Consider the following tips when working with the members list:

• To hide the search filters, click Hide Search in the left corner above the search options on the Add Members subtab, or
click Hide Filters in the left corner above the filters on the Existing Members subtab.

• To clear the search filters, click Clear Filters under the filters.
• Navigate through the list results by clicking the first page icon (<<), Previous, Next, or the last page icon (>>) at the bottom

of the list.
• Jump to a specific page of results by entering a number in the text box in the lower right corner and then pressing Enter.
• Change the number of records displayed per page by clicking the record count indicator in the lower left corner of the list

and choosing a number. You can view 10, 25, 50, 100, or 200 records at a time. When you change this setting, you return
to the first page of list results. Changing your preference for the number of records displayed per page applies to all lists
in all Salesforce apps, not just the list currently displayed. In addition, if you change your preference to 200, a message
warns you of possible performance degradation.

• Change the width of a column by dragging the right side of the column heading with your mouse. Any changes you make
to column widths are specific to this list only, and the changes are retained when you next view the list.

• Click the Edit Columns link in the upper right corner of the list to add or remove columns.

Note: The latest Manage Members page is not available in accessibility mode. For help with managing members in
accessibility mode, see Mass Adding Contacts or Leads to a Campaign, Mass Updating the Status of Campaign
Members, or Mass Removing Contacts or Leads from a Campaign.

Email-to-Case as a Service

Available in: Professional, Enterprise, Unlimited, and Developer Editions

With Spring '09, converting email to cases is now easier than ever and available as a service. Using the new On-Demand
Email-to-Case feature, you can use the Force.com email service to convert email to cases without having to download and
install an agent behind your network's firewall. On-Demand Email-to-Case converts email messages sent to one of your
company’s email addresses to case records so that your support team can easily manage customer inquiries.

Implementation Tips

• Use On-Demand Email-to-Case if you are not concerned about keeping email traffic within your firewall, and you do not
need to accept attachments larger than 10 MB from customers.

24

Salesforce Applications



• Forward email messages from existing support email addresses, such as support@mycompany.com, to the automatically
generated On-Demand Email-to-Case address (Email Services Address).

• When a customer sends an email to an email address you have defined for On-Demand Email-to-Case, a case is created
in your organization with the email subject as the case Subject and the email body as the case Description.

• Salesforce limits the total number of messages that On-Demand Email-to-Case can process to 2500 email messages per
day. Messages that exceed this limit are bounced, discarded, or queued for processing the next day, depending on how you
configure Over Rate Limit Action settings for On-Demand Email-to-Case.

• Text in an email that is in between 32 KB and 100 KB is automatically truncated to 32 KB to fit a case record. If text in
an email is over 100 KB, the email will bounce.

• You can limit the email addresses and domains available for On-Demand Email-to-Case by entering them in the Accept
Email From field.

• We recommend naming routing addresses according to the audience they serve. For example, Gold Support or Standard
Support.

• If there is an error processing an email to a case via a routing address, then a notification is sent to the user who created
the routing address.

• If email is sent to a routing address or email services address when On-Demand Email-to-Case is disabled, then a notification
is sent to the user who created the routing address.

Best Practices

• Create email templates that support reps can use to respond to On-Demand Email-to-Case emails. These templates can
include merge fields that display information from the original email in the response. For more information, see "Managing
Email Templates" in the Salesforce online help.

• To save storage space, do not select the Save Email Headers checkbox when creating a routing address. Email headers
contain email routing information that does not typically help customer support reps resolve cases.

• Select the Create Task from Email checkbox to automatically assign a task to the case owner when an email is submitted
as a case.

• Select the Enable HTML Email checkbox to warn users before they view incoming HTML email content so that they
can avoid opening potentially malicious HTML that could harm their computers. With this setting disabled, users see
text instead of HTML on email message detail pages, and when users reply to an email, the text version of the email is
copied to the email editor, instead of the HTML version.

• Click the Notify Case Owners on New Email checkbox to allow case owners to automatically receive notifications
when email arrives for their existing cases. Email notifications assign a task to the case owner to respond to the new email.
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About Email-to-Case as a Service

Setting Up Email-to-Case or On-Demand Email-to-Case

Email-to-Case is available in: Professional, Enterprise, Unlimited, and Developer Editions

On-Demand Email-to-Case is available in Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To set up Email-to-Case or On-Demand Email-to-Case:

"Modify All Data"

AND

"Customize Application"

To enable Email-to-Case or On-Demand Email-to-Case:

Salesforce can automatically create a case when an email is sent to one of your company’s email addresses, such as
support@company.com. This Email-to-Case functionality auto-populates case fields from the content of each email. For
example, an email subject heading becomes a case subject. Your organization can set up Email-to-Case or On-Demand
Email-to-Case to efficiently resolve and correspond with customer inquiries via email.

Salesforce allows you to choose one of two Email-to-Case options:

Email-to-Case

Email-to-Case requires downloading the Email-to-Case agent from wiki.apexdevnet.com/index.php/Email_To_Case
and installing the agent behind your network's firewall.

Use Email-to-Case if you have a requirement to keep all email traffic within your firewall, and you want to accept email
attachments larger than 10 MB from customers.

On-Demand Email-to-Case

On-Demand Email-to-Case uses Apex email services to convert email to cases, without you having to download and
install an agent behind your network's firewall.

Use On-Demand Email-to-Case if you are not concerned about keeping email traffic within your firewall, and you do
not need to accept attachments larger than 10 MB from customers.

Setting Up Email-to-Case

The following high-level steps outline how to set up Email-to-Case:

1. Determine the email routing addresses that your customers can use to submit cases to your support team. Emails are
automatically converted to cases based on the settings specified for each routing address.

2. In Salesforce, enable Email-to-Case and configure your email routing addresses. See "Enabling and Configuring
Email-to-Case" in the Salesforce online help.

3. Download the Email-to-Case agent from wiki.apexdevnet.com/index.php/Email_To_Case.
4. Install the agent behind your network’s firewall.
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5. Test your email routing addresses:

a. Manually send emails to the routing addresses.
b. Verify that the emails convert to cases based on their routing address settings.

6. Add the email address that you configured to your company's support website. This is the email address customers can use
to submit cases to your support team.

7. Add the Emails related list to the Cases page layout. For more information, see "Customizing Page Layouts" in the
Salesforce online help.

Note: You can create email templates that support reps can use to respond to Email-to-Case or On-Demand
Email-to-Case emails. These templates can include merge fields that display information from the original email in
the response. See "Managing Email Templates" in the Salesforce online help.

Setting Up On-Demand Email-to-Case

The following high-level steps outline how to set up On-Demand Email-to-Case:

1. Determine the email routing addresses that your customers can use to submit cases to your support team. Emails are
automatically converted to cases based on the settings specified for each routing address.

2. In Salesforce, configure your email routing addresses and enable On-Demand Email-to-Case. See "Enabling and Configuring
On-Demand Email-to-Case" in the Salesforce online help.

3. Configure your email system to forward case submissions to the email services address provided to you by Salesforce. For
more information, see your email system's documentation.

4. Test your email routing addresses:

a. Manually send emails to the routing addresses.
b. Verify that the emails convert to cases based on their routing address settings.

5. Add the email address that you configured to your company's support website. This is the email address customers can use
to submit cases to your support team.

6. Add the Emails related list to the Cases page layout. For more information, see "Customizing Page Layouts" in the
Salesforce online help.

Note: You can create email templates that support reps can use to respond to Email-to-Case or On-Demand
Email-to-Case emails. These templates can include merge fields that display information from the original email in
the response. See "Managing Email Templates" in the Salesforce online help.
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Enabling and Configuring On-Demand Email-to-Case

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To set up On-Demand Email-to-Case

"Modify All Data"

AND

"Customize Application"

To enable On-Demand Email-to-Case

This topic describes how to enable and configure On-Demand Email-to-Case using the options available on the Email-to-Case
Settings page. In addition, refer to Setting Up On-Demand Email-to-Case for the high-level steps you should perform before
and after the tasks described in this topic.

Before getting started, review the information in "Tips and Considerations for On-Demand Email-to-Case" in the Salesforce
online help.

To enable and configure On-Demand Email-to-Case, perform the following procedures in order:

1. Enabling On-Demand Email-to-Case
2. Defining and Verifying Email Routing Addresses
3. Configuring Email-to-Case Settings

Enabling On-Demand Email-to-Case

To enable On-Demand Email-to-Case:

1. Click Setup ➤ Customize ➤ Cases ➤ Email-to-Case to open the Email-to-Case settings page.
2. Click Edit.
3. Select the Enable Email-to-Case checkbox. After you enable Email-to-Case, it cannot be disabled.
4. Select the Enable On-Demand Service checkbox.

To disable On-Demand Email-to-Case at any time, deselect the checkbox. You can also re-enable On-Demand
Email-to-Case at any time.

5. Click Save. You will configure the remaining settings later.

Defining and Verifying Email Routing Addresses

To define and verify email routing addresses:

1. Click Setup ➤ Customize ➤ Cases ➤ Email-to-Case to open the Email-to-Case settings page.
2. On the Routing Addresses related list, click New.
3. Enter the routing address settings:

DescriptionSetting

The name for the routing address. For example, Gold
Support or Standard Support.

Routing Name
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DescriptionSetting

The inbound email address for this On-Demand
Email-to-Case routing address. Email sent to this address

Email Address

creates new cases using the specified settings. The email
address must be unique.

Note that this is the email address to which you will provide
a link on your company's support website.

Select this checkbox to save the email routing information
associated with each email submitted as a case. Saving email

Save Email Headers

routing information counts towards your organization's
overall storage limit. For more information, see "Monitoring
Resources" in the Salesforce online help.

To view email headers from an email converted to a case,
see "Working with Case Emails" in the Salesforce online
help.

Leave this field blank to allow On-Demand Email-to-Case
to receive email from any email address or domain. Or, you

Accept Email From

can limit the email addresses and domains available for
On-Demand Email-to-Case by entering them in this field.

Select this checkbox to automatically assign a task to the
case owner when an email is submitted as a case.

Assignment rules automatically assign owners to a case;
however, if a case does not match assignment rule criteria,

Create Task from Email

then the user in the Default Case Owner field on the
Support Settings page is assigned to the case. For more
information, see "Setting Up Assignment Rules" in the
Salesforce online help and "Customizing Support Settings"
in the Salesforce online help.

Choose a status from this drop-down list with which to
predefine the Status field on tasks automatically assigned
to case owners when email is submitted as cases.

This setting is only available if you selected the Create
Task from Email checkbox.

Task Status

The priority assigned to cases created from emails sent to
this email routing address.

Case Priority

The value assigned to the Case Origin field for email sent
to this email routing address.

Case Origin

The record type used to create cases from emails sent to this
email routing address.

This setting is not available if your organization does not
use record types.

Case Record Type

4. Click Save to save the routing address settings.
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Alternatively, click Save & New to save the routing address, and then create a new routing address.

A verification email is immediately sent to the new routing address which includes a link that you click to complete the
verification process. The new routing address will not be verified until you open the email and click the link.

5. Click the link in the verification email.

When the new email routing address is verified, it is listed as Verified in the Routing Addresses related list on the
Email-to-Case Settings page. In addition, Salesforce automatically generates a unique email service address with which
you configure your email system to forward case submissions.This email services address displays in the Routing Addresses
related list on the Email-to-Case Settings page and on the detail page of a each routing address.

Tip: To send additional verification emails to a new routing address, go to the Routing Addresses related list on the
Email-to-Case Settings page and click Verify next to the email address.

After verifying a routing address, click its name in the Routing Addresses related list to view its details, edit its settings,
or clone new copies of it.

Configuring Email-to-Case Settings

To configure Email-to-Case settings:

1. Click Setup ➤ Customize ➤ Cases ➤ Email-to-Case to open the Email-to-Case settings page.
2. Click Edit.
3. As appropriate, set the following options:

DescriptionOn-Demand Email-to-Case Setting

Select this checkbox to allow case owners to automatically
receive notifications when emails arrive for their existing

Notify Case Owners on New Email

cases. Email notifications assign a task to the case owner to
respond to the new email when the Create Task from
Email checkbox is selected. Responding to the email closes
the task. To disable email notifications at any time, simply
deselect the checkbox.

Select this checkbox to warn users before they view incoming
HTML email content so that they can avoid opening

Enable HTML Email

potentially malicious HTML that could harm their
computers. With this setting disabled, users will see text
instead of HTML on email message detail pages, and when
users reply to an email, the text version of the email will be
copied to the email editor, instead of the HTML version.
To disable HTML email warnings at any time, simply
deselect the checkbox.

Select this checkbox to add the thread ID to the subject of
email.

You can choose whether the thread ID should be included
in the emails users send from cases. The thread ID is the

Email Subject

unique ID of each case email, such as
[ref:00DxRtp.500xXFKf:ref ]. By default, the thread ID is
added to both the subject and body of case emails.
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DescriptionOn-Demand Email-to-Case Setting

Select this checkbox to add the thread ID to the body of
email.

You can choose whether the thread ID should be included
in the emails users send from cases. The thread ID is the

Email Body

unique ID of each case email, such as
[ref:00DxRtp.500xXFKf:ref ]. By default, the thread ID is
added to both the subject and body of case emails.

Choose what On-Demand Email-to-Case does with email
that surpasses the daily email processing limit for your
organization:

Over Email Rate Limit Action

• Bounce message - The email service returns the message
to the sender with a notification that explains why the
message was rejected.

• Discard message - The email service deletes the message
without notifying the sender.

• Requeue message - The email service queues the message
for processing in the next 24 hours. If the message is not
processed within 24 hours, the email service returns the
message to the sender with a notification that explains
why the message was rejected.

For more information on email processing limits, see Tips
and Considerations for On-Demand Email-to-Case.

If you limited the email addresses and domains available for
On-Demand Email-to-Case in the Accept Email From

Unauthorized Sender Action

field, choose what happens to messages received from senders
who are blocked:
• Bounce message - The email service returns the message

to the sender with a notification that explains why the
message was rejected.

• Discard message - The email service deletes the message
without notifying the sender.

4. Click Save.

Tips and Considerations for On-Demand Email-to-Case

Consider the following when setting up routing addresses for On-Demand Email-to-Case:

• When a customer sends an email to a routing address, a case is created in your organization with the email subject as the
case Subject and the email body as the case Description.

• Salesforce limits the total number of messages that On-Demand Email-to-Case can process to 2500 email messages per
day. Messages that exceed this limit are bounced, discarded, or queued for processing the next day, depending on how you
configure "over email rate limit settings" in the Salesforce online help.
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• The Priority, Case Origin, and Case Record Type fields auto-populate the case via the routing address settings
when the routing address is included in either the To, CC, or BCC fields of an inbound email.

• Salesforce processes the routing address of an inbound email in the following order and stops at the first match:

1. To

2. CC

3. BCC

Note that some email applications do not automatically send BCC information.Therefore, case fields may not auto-populate
properly if the routing address is included in the BCC field of an inbound email. Furthermore, an email may not convert
to a case properly if you include the email services address in the BCC field of an email.

• To have cases that are created via On-Demand Email-to-Case automatically display in the Self-Service portal, see "Enabling
Self-Service Features and Settings" in the Salesforce online help.

• Deselect both the Email Subject and Email Body checkboxes to prevent the thread ID from being added to email.

If you deselect both the Email Subject and Email Body checkboxes, then all incoming responses to outbound case
emails create new cases.

• If there is an error processing an email to a case via a routing address, then a notification is sent to the user who created
the routing address.

• Text in an email that is in between 32 KB and 100 KB is automatically truncated to 32 KB to fit a case record. If text in
an email is over 100 KB, the email will bounce.

• If email is sent to a routing address or email services address when On-Demand Email-to-Case is disabled, then a notification
is sent to the user who created the routing address.

• When you reply to email messages in the Email related list on cases, the From: field on your email may display to recipients
as no-reply@salesforce.com or support@company.com. This is due to how the recipients' email applications
receive Sender and From headers on inbound email. By default, an Enable Sender ID compliance setting is selected
for your organization, which enables email messages sent from Salesforce to comply with email applications that require
Sender headers for delivery. For more information, see "Configuring Deliverability Settings" in the Salesforce online help.

Customer Portal Enhancements

Available in: Enterprise, Unlimited, and Developer Editions

With Spring '09, you can extend the user, case, and contact management capabilities of Salesforce to your customers via the
Customer Portal. A Customer Portal provides an online support channel to your customers, allowing them to resolve their
inquiries without contacting a customer service representative.

The new capabilities delivered in the Customer Portal include:

Customer Administration

You can delegate a subset of administrative rights to Customer Portal users. Delegated Customer Portal user administrators
can do any of the following for users associated with their own account:

• Create new Customer Portal users
• Edit existing Customer Portal users
• Reset passwords for Customer Portal users
• Deactivate Customer Portal users
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Customer Portal Super User

You can add the "Portal Super User" permission to custom portal profiles so that users can do the following for their
own account:

• View and edit all cases
• View and edit all contacts

About Customer Administration and Portal Super User

Delegate Customer Portal User Administration and Portal Super User

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Delegated Portal User Administrator"To manage Customer Portal users:

"Manage Users"To create, edit, and delete profiles:

"Portal Super User"To view and edit all cases and contacts for an account:

You can delegate a subset of administrative rights to Customer Portal users. Delegated Customer Portal user administrators
can do any of the following for users associated with their own account:

• Create new Customer Portal users
• Edit existing Customer Portal users
• Reset passwords for Customer Portal users
• Deactivate existing Customer Portal users

Delegated Customer Portal user administrators can also view their account's detail page, along with contacts and cases related
to their account via the Accounts tab. In addition, delegated Customer Portal user administrators automatically receive the
"Portal Super User" permission. This permission enables delegated Customer Portal user administrators to do the following
for their own account:

• View and edit all cases
• Create cases for contacts
• View and edit all contacts, whether portal enabled or not
• Report on all contacts, whether portal enabled or not, if the Reports tab is added to your Customer Portal and the user

has the "Run Reports" permission

You can add just the "Portal Super User" permission to the profiles of portal users so that they can view and edit all cases and
contacts for their account, without having the ability to manage other portal users. However, portal super users cannot view
the Contacts tab on the Customer Portal without the "Delegated Portal User Administrator" permission. To edit contacts,
portal super users must select a contact from a case record. For more information, see:

• Delegating Customer Portal User Administration Rights
• Providing Users with the "Portal Super User" Permission
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• Tips on Setting Up Delegated Customer Portal User Administration

Delegating Customer Portal User Administration Rights

To delegate Customer Portal User Administration Rights:

1. Click Setup ➤ Manage Users ➤ Profiles and click a custom Customer Portal profile.

You cannot add delegation rights or the "Portal Super User" permission to the standard Customer Portal Manager and
Customer Portal User profiles.

2. Click Edit.
3. Select Delegated Portal User Administrator.

When you select Delegated Portal User Administrator, the Portal Super User is automatically selected after you click
Save.

4. Click Save.
5. In the Delegated Portal Profiles related list, click Edit.
6. Select the Customer Portal profiles you want users with this profile to be able to administer.
7. Click Save.

To change which profiles a delegated Customer Portal user administrator can edit:

1. Click Setup ➤ Manage Users ➤ Profiles and click a custom Customer Portal profile.
2. Click Edit in the Delegated Portal User Profiles related list.
3. Select the Customer Portal user profiles you want this profile to be able to administer.
4. Click Save.

Delegated Customer Portal administrators can perform the following tasks from a contact's detail page:

• Click Enable Customer Portal User to allow a contact to use a Customer Portal.
• Click View Customer Portal User to view the Customer Portal user's details. From a Customer Portal user's detail page,

delegated Customer Portal users can:

- Click Edit to edit a Customer Portal user's details.
- Click Reset Password to reset the Customer Portal user's password.

Providing Users with the "Portal Super User" Permission

To provide users with the "Portal Super User" permission:

1. Click Setup ➤ Manage Users ➤ Profiles and click a custom Customer Portal profile.

You cannot add the "Portal Super User" permission to the standard Customer Portal Manager and Customer Portal User
profiles.

2. Click Edit.
3. Select Portal Super User.
4. Click Save.

Tip: To report on profiles with the "Portal Super User" permission:

1. Note the names of profiles with the "Portal Super User" permission.
2. Select the Reports tab.
3. From the Administrative Reports folder, select the All Active Users report.

For more information, see "Administrative Reports" in the Salesforce online
help.
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Tips on Setting Up Delegated Customer Portal User Administration

Consider the following when setting up delegated Customer Portal User Administration:

• On the profile of users you are granting delegated portal administration:

- Add the "Delegated Portal User Administrator" permission.

The "Portal Super User" permission is automatically added when you add the "Delegated Portal User Administrator"
permission and click Save.

- Add the "Create" and "Edit" permissions on contacts so that delegated portal administrators and users with the "Portal
Super User" permission can create and update contacts related to their account.

- Set the tab setting for Accounts and Contacts to Default On so that delegated portal administrators can view the
Accounts and Contacts tabs and easily manage contacts related to their accounts.

- For more information on the above items, see "Creating and Editing Profiles" in the Salesforce online help.

• Add the Accounts and Contacts tabs to your Customer Portal. For more information, see "Customizing Your Customer
Portal Tabs" in the Salesforce online help.

• Set field-level security and page layouts so that delegated Customer Portal user administrators and portal super users can
only access the account, contact, and case fields you specify. For more information, see "Setting Field-Level Security" in
the Salesforce online help and "Managing Page Layouts" in the Salesforce online help.

Note: To allow portal super users to create cases for contacts other than themselves, set the field-level security on
the Contact Name field on cases to Editable.

• Note that Customer Portal users are automatically prevented from viewing related lists to objects which they do not have
access. For example, if a Customer Portal user views a contact, and the contact page layout includes the Opportunities
related list, the portal user cannot view the Opportunities related list because portal users do not have access to opportunities.

Global Business Hours for Holidays

Available in: Professional, Enterprise, Unlimited, and Developer Editions

With Spring '09, you can add holidays to business hours. Holidays enable you to easily suspend business hours, and escalation
rules associated with business hours, during any days and times when your customer support team is unavailable. Holidays
allow for more accurate start and end times on customer issues.

Implementation Tips

• You can define a holiday once and associate it to multiple business hours. For example, you may have business hours for
San Francisco and Hong Kong, but you can create one holiday for New Years Day and associate it to both sets of business
hours.

• Holidays automatically acquire the time zone of the business hours with which they are associated. For example if you
associate a holiday to business hours that are in Pacific Standard Time, the holiday will take effect for those business hours
in Pacific Standard Time.

• You can easily create new holidays from elapsed holidays that are similar by clicking Clone next to holidays in the Elapsed
Holidays related list.

• To learn more about business hours, see "Setting Business Hours" in the Salesforce online help.
• Currently, report results do not take into account holidays.
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• Previously, users needed the "Customize Application" permission to update business hours. However, with the introduction
of holidays, users now need the new "Manage Business Hours Holidays" permission to update business hours and holidays.
The "Manage Business Hours Holidays" permission is automatically on for users who currently have the "Customize
Application" permission.

Best Practices

• For frequently recurring holidays, select the Recurring Holiday checkbox to schedule the holiday to recur during specific
dates and times.

• We recommend that you enter text in the Holiday Name field that will easily remind users of a holiday. For example,
considering naming a holiday New Year's Day instead of January 1.

About Global Business Hours for Holidays

Setting Holidays

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Manage Business Hours Holidays"To set holidays:

Holidays enable you to specify the dates and times at which your customer support team is unavailable. After you create a
holiday, you can associate it with business hours to suspend business hours and escalation rules during the dates and times
specified in the holiday. For more information, see "Setting Business Hours" in the Salesforce online help and "Setting Up
Escalation Rules" in the Salesforce online help.

To set holidays:

1. Click Setup ➤ Company Profile ➤ Holidays.

• Click Edit to edit an existing holiday.
• Click Del to delete an existing holiday.

You can only delete a holiday that is not associated with any business hours.

• Click Clone next to an elapsed holiday to clone it.

The Elapsed Holidays related list displays holidays that have occurred in the past. You can only clone elapsed holidays.

If the Go to list link appears at the bottom of the Holidays or Elapsed Holidays related list, click it to display all the
items. From the list you can edit or delete any existing holiday, or clone any elapsed holiday.

Caution:  Any elapsed holidays that you delete are not moved to the Recycle Bin. They cannot be recovered.

The recurring icon ( ) displays next to the date and time of recurring holidays.

2. Click New.
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3. Enter a name for the holiday.
4. Enter a date for the holiday.

If you want the holiday to span more than one day:

a. Select the Recurring Holiday checkbox
b. Enter the first day of the holiday in the Start Date field.
c. Deselect the No End Date checkbox in the End Date field.
d. Enter the last day of the holiday in the End Date field.

5. Optionally, you can:

• Specify the exact times at which the holiday takes place by deselecting the All Day checkbox next to the Time field
and entering the exact times.

• Select the Recurring Holiday checkbox to schedule the holiday to recur during specific dates and times:

- In the Frequency field, select the frequency at which the holiday recurs. When you click the Daily, Weekly, or
Monthly fields, more options display that allow you to refine frequency criteria.

- In the Start Date and End Date fields, specify the dates during which you wish the holiday to recur.

The following error message displays if you select a start date and end date that does not correspond with the
frequency you selected: The recurring holiday has no occurrence.

6. Click Save.
7. Click Add/Remove on the Business Hours related list.
8. Add or remove business hours to the holiday by selecting business hours in the Available Business Hours column, and

clicking the Add or Remove arrows to add or remove business hours to the Selected Business Hours column.
9. Click Save.

Tips on Setting Holidays

Consider the following when setting holidays:

• You can associate a holiday to multiple business hours.
• Holidays automatically acquire the time zone of the business hours with which they are associated. For example if you

associate a holiday to business hours that are in Pacific Standard Time, the holiday will take effect for those business hours
in Pacific Standard Time.

• Holiday names do not need to be unique. For example, you could enter multiple holidays named New Year's Day.
• Currently, there are no limits to how many holidays you can create for your organization.
• Currently, report results do not take into account holidays.
• If you schedule a holiday to recur on a specific day of every month, the holiday will only recur on months that have that

specific day. For example, if you schedule a holiday on the 31st day of every month, then the holiday will only recur on
months that have 31 days. If you want a holiday to recur on the last day of every month, choose last from the On day of
every month drop-down list.

• You can only add business hours marked as Active to holidays. For more information, see "Setting Business Hours" in
the Salesforce online help.
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Opportunity Genius: Finding Similar Opportunities

Available in: Enterprise, Unlimited, and Developer Editions

The new Opportunity Genius: Finding Similar Opportunities feature enables you to find deals that look like yours using a
variety of search criteria. You can then reach out to the reps who closed them and bookmark similar deals to reference as your
opportunity progresses.

Successful sales organizations share and internalize best practices to make sure every rep is armed with the knowledge needed
to close their deals. Reps can use Opportunity Genius: Finding Similar Opportunities to reach out to each other directly and
learn from the experience of their colleagues.

Using Opportunity Genius: Finding Similar Opportunities, you can:

• Search based on the fields you've filled out on your own opportunity
• Tune the matching criteria to fit your sales organization with the help of your administrator
• Bookmark similar deals against your opportunity to reference as your deal progresses

About Opportunity Genius: Finding Similar Opportunities

Enabling Similar Opportunities

Available in: Enterprise, Unlimited, Developer Editions

User Permissions Needed

"Customize Application"To enable similar opportunities:

On the opportunity detail page, the Similar Opportunities related list displays opportunities that match attributes of the current
opportunity. Enabling this related list allows users to learn how their current opportunities relate to other opportunities in
Salesforce.

1. Click Setup ➤ Customize ➤ Opportunities ➤ Similar Opportunities.
2. Click Edit.
3. Select Enable Similar Opportunities to add the Similar Opportunities related list to the opportunity detail page.
4. Edit the search criteria and columns as necessary.
5. Add the Similar Opportunities related list to the opportunity page layout. For more information, see "Customizing Page

Layouts" in the Salesforce online help.
6. Click Save.

Important:  Enabling similar opportunities gives all users in your organization limited visibility into private
opportunities, regardless of sharing rules and profile permissions. Once enabled, users will see information for any
opportunity that matches fields you choose to display in the Similar Opportunities related list.
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Editing the Similar Opportunities Search Criteria

You can determine which opportunity fields to match against when finding similar opportunities, and which columns to show
in the related list.

1. Select the opportunity fields or related lists that you want to match against when finding similar opportunities and click
Add. You must select between three and ten fields.

The following standard fields are supported:

• Private
• Close Date
• Probability (%)
• Account Name
• Primary Campaign Source
• Quantity
• Lead Source
• Opportunity Owner
• Type

The following standard related lists are supported:

• Products
• Contact Role
• Partner
• Competitors
• Sales Team

You can select any custom opportunity field, with the exception of those with the following field types:

• auto-number
• currency
• formula
• picklist (multi-select)
• roll-up summary
• text (encrypted)
• text area

2. Select the fields to use as columns on the Similar Opportunities related list.

a. Select the columns in the Available Columns box and click Add to move the columns to the Selected Columns box.

If necessary, select Remove to move columns from the Selected Columns box to the Available Columns box.
You can select up to 15 columns.

b. Use the up and down arrows to organize the selected columns in the appropriate order.

3. Click Save.
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Finding Similar Opportunities

Available in: Enterprise, Unlimited, Developer Editions

User Permissions Needed

"Read" on opportunitiesTo view and find similar opportunities:

The Similar Opportunities related list on the opportunity detail page displays other opportunities within your organization
that share one or more attributes with your opportunity. For example, you may have bookmarked past opportunities for the
same customer so that you can refer back to the notes and contact the salesperson for advice if necessary.

• To view an opportunity, click on the opportunity name. You can view details for any opportunity to which you have "Read"
access.

• To remove an opportunity from the Similar Opportunities related list, click the Del link next to the appropriate opportunity.
• To search for and bookmark more opportunities, click Find.

The opportunities that appear in the search results are determined by the administrator, who chooses which fields to match
against. The search results include only opportunities with a Closed Won Stage. The results are ranked by the opportunity
with the highest number of matching fields.

Note: When finding similar opportunities, Salesforce searches against a maximum of 10,000 Closed Won opportunities
within the past three months and returns up to 300 of the most relevant opportunities.

• Use the Close Date Within drop-down list to filter the matching opportunities by their close date. The default shows
opportunities closed within the past three months.

• In the Match Criteria sidebar, select one or more of the matching fields to further filter the results. For example, selecting
a specific account or primary competitor will narrow the list down to show only those opportunities for the selected account
or that contain the selected primary competitor. Deselect the fields to return to the original result set.

• Hover over an opportunity name to see which criteria the opportunity matches. The matching attributes are highlighted
in the Match Criteria sidebar.

• Click on an opportunity name link to view details. You can only view details for opportunities to which you have access.
• Click on the drop-down button  on the bottom left side of the page to change the number of records displayed. By

default, the page displays 25 records.
• Click the Previous or Next arrows to navigate to the previous or next page. To advance to a particular page, type a

number in the Page field on the bottom right side of the screen.

Bookmarking Similar Opportunities

You can bookmark opportunities you would like to reference as you work on your deal. These opportunities are saved on the
Similar Opportunities related list.

1. Select the appropriate opportunities. To choose all opportunities on the page, select the checkbox in the header row.
2. Click Bookmark.

You can find and bookmark opportunities at any time by clicking Find in the Similar Opportunities related list.
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New Opportunity Save Behavior

Available in: All Editions

With Spring ‘09, workflow rules, validation rules and Apex triggers on opportunities and opportunity products will fire when
an update to a child opportunity product or schedule causes an update to the parent record.This means your custom application
logic will be enforced when there are updates to the parent record, ensuring higher data quality and compliance with your
organization’s business policies.

Implementation Tips

• This feature is dependent on the Workflow and Roll-Up Summary Field Evaluations update. You must activate that update
first. See Workflow Rule and Roll-Up Summary Field Evaluations Update.

• By default, all organizations signed up after the Spring ‘09 release will see this behavior.
• Starting in March 09, salesforce.com will begin rolling out the New Opportunity Save Behavior update in phases. Once

available, you will see the update on the Critical Updates page. The update will be auto-enabled for organizations not
currently using any of the customizations listed below. These customers will be required to review the update and take the
necessary actions in order to enable the update prior to its auto-activation date.

• The following customizations could cause a change in behavior when you activate the update:

- Opportunity and opportunity product validation rules
- Opportunity and opportunity product universally required fields
- Opportunity and opportunity product unique fields
- Opportunity and opportunity product triggers
- Opportunity and opportunity product workflow rules
- Triggers on any object that cause an update to the opportunity and/or opportunity product

Best Practices

You can activate this update in both your sandbox and production environments. Salesforce.com recommends testing the
update by activating it in your sandbox environment prior to activating in your production environment. It is also recommended
that you perform a refresh to your sandbox organization prior to activation to ensure that your sandbox and production
organizations have the same customizations.
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About the New Opportunity Save Behavior

What is the Spring '09 New Opportunity Save Behavior Update?

Available in: All Editions

User Permissions Needed

"View Setup"To view the Spring ’09 New Opportunity Save Behavior
Update:

"Customize Application" and "Modify All Data"To activate the Spring ’09 New Opportunity Save Behavior
Update:

The Spring ’09 New Opportunity Save Behavior update affects how Salesforce processes your organization's custom logic
when changes you make to an opportunity product or schedule affect the following cumulative fields on its parent record:

• Opportunity Amount
• Opportunity Quantity
• Opportunity product Total Price

• Opportunity product Unit Price

• Opportunity product Quantity
• Any opportunity roll-up summary field

Note:  If your opportunity has a roll-up summary field that rolls up the product list price, and a product's list price
is updated in the associated price book, the roll-up summary field on the opportunity will get updated but custom
opportunity or opportunity product save logic will not apply.

Activation of the New Opportunity Save Behavior update results in the following changes to application logic:

New Opportunity Save Behavior
Activated

New Opportunity Save Behavior
Deactivated

Customization on Parent Records

Triggers on parent record ARE fired
upon parent cumulative field update

After triggers run before the parent
cumulative field has been updated

Triggers on parent record are NOT fired
upon parent cumulative field update

After triggers run after the parent
cumulative field has been updated

Apex triggers

Enforced when an update to a child
opportunity product or schedule record

Rules on parent record are NOT fired
upon parent cumulative field update

Unique Field Validation Rule

Universally Required Field Validation
Rule updates any of the cumulative fields

mentioned above
Custom Validation Rule
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New Opportunity Save Behavior
Activated

New Opportunity Save Behavior
Deactivated

Customization on Parent Records

Rules for field update on parent record
will run unique field validation,

Evaluated if an update to a child
opportunity product or schedule record

Workflow rule (field update) - on the
parent record with the criteria ”Every
time a Record is Created or Edited” universally required field validation, and

Apex triggers
impacts the cumulative fields on the
parent record

Rules for a field update on parent record
will run custom validation rules, unique
field validation, universally required field
validation, as well as Apex triggers.

Rules on parent record are ONLY fired
upon parent cumulative field update

Rules on the child record are evaluated
based on "current" value of the parent

Rules on parent record ARE fired
regardless of parent cumulative field
update

Rules on the child record are evaluated
based on "updated" value of the parent
record

Workflow rule (task or email)

record, that is the value of the cumulative
field before it was updated by the change.

For more information on triggers and
order of execution, see the Apex
Language Reference.

Additionally, this update introduces changes to opportunity save behavior when cloning an opportunity with products. With
this update, custom logic such as validation rules, workflow rules, and Apex triggers will run on opportunity products as well
as the parent opportunity when you clone an opportunity with products. Furthermore, errors during cloning will occur if the
opportunity with products being cloned has a unique field constraint on the opportunity product, as the value in the unique
field would violate the constraint based on the copied value.

Important:  Activation of this update impacts opportunity and opportunity product records in the user interface,
API, and desktop clients.

Salesforce.com recommends activating this update because it improves the consistency of your custom application logic and
the quality of your data.

The Spring ’09 New Opportunity Save Behavior is automatically enabled for all new customers that sign up after the Spring
'09 release in February 2009. Starting in March 09, salesforce.com will begin rolling out the New Opportunity Save Behavior
update in phases. Once available, you will see the update on the Critical Updates page. The update will be auto-enabled for
organizations not currently using any of the customizations listed below.These customers will be required to review the update
and take the necessary actions in order to enable the update prior to its auto-activation date.

• Opportunity and opportunity product validation rules
• Opportunity and opportunity product universally required fields
• Opportunity and opportunity product unique fields
• Opportunity and opportunity product triggers
• Opportunity and opportunity product workflow rules
• Triggers on any object that cause an update to the opportunity and/or opportunity product
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Salesforce.com recommends testing the update by activating it in either your Sandbox or your production environment during
off-peak hours. You can activate and deactivate the update an unlimited number of times. Leave the update activated if it does
not cause any unintended behavior.

Packaging Considerations

Because this update may cause Salesforce to run your custom application logic in situations where it did not run before,
Salesforce may block your organization from downloading packages from the AppExchange to prevent data corruption and
application functionality.

Packages will be designated as available for new save behavior, old save behavior, or both. Package developers can create a
package that will work in both new and old save behavior subscriber organizations.The package will be blocked from installation
into your organization if the following are all true:

• The package contains any of the following customizations:

- Opportunity and opportunity product universally required fields
- Opportunity and opportunity product unique fields
- Opportunity and opportunity product triggers
- Opportunity and opportunity product workflow rules (email/tasks/field updates)

• The package was built on a save behavior that is different from your current setting
• The package developer has not confirmed that the package will function properly in both old and new save behavior

If your organization is blocked from installing a package we recommend that you contact the package developer in order to
obtain a version that is safe to download.

Activating the Spring ’09 New Opportunity Save Behavior Update

To activate the Spring ’09 New Opportunity Save Behavior update:

1. Click Setup ➤ Critical Updates.
2. Click Review next to the Spring ’09 New Opportunity Save Behavior Update. Salesforce displays the update detail page,

which includes a list of the customizations in your organization that the update might affect.
3. Review each customization to assess if activating the update will cause any of your customizations to function in a way that

is not intended. Read the examples below and the table above to understand how your customizations might be affected
and how you can correct any unintended functionality. If the update will cause unintended behavior, modify the customization
before activating the update.

4. Click Activate.
5. Optionally, enter comments about this activation and click Activate. The comments appear in the activation history.

Deactivating the Spring ’09 New Opportunity Save Behavior Update

To deactivate the Spring ’09 New Opportunity Save Behavior Update:

1. Click Setup ➤ Critical Updates.
2. Click Review next to the Spring ’09 New Opportunity Save Behavior Update. Salesforce displays the update detail page.
3. Click Deactivate.
4. Optionally enter comments about this deactivation and click Deactivate. For example, you can explain why you are

deactivating the update and list any unintended behavior the update causes.The comments appear in the activation history.
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Examples

Validation Rule Example

Consider a situation in which you have the following validation rule on opportunities, which requires the Stage field
to be set to Qualifying if the opportunity is greater than $10,000:

OR (AND (ISPICKVAL (StageName, "Qualifying"), Amount > 10000), Amount <= 10000)

If the Spring ’09 New Opportunity Save Behavior Update is inactive, Salesforce runs this validation rule when you edit
an opportunity but not when you edit the opportunity product or schedule and it updates the opportunity amount or
quantity. As a result, if the amount of the opportunity product changes, the associated opportunity could be in an invalid
state.

If the Spring ’09 New Opportunity Save Behavior Update is activated, Salesforce runs this validation rule both when
you edit an opportunity and when you edit the opportunity product if the changes to the opportunity product affect the
associated opportunity's amount or quantity. This prevents you from saving the opportunity product until the correct
stage is set on the opportunity.

Apex Trigger Example

Assume that an organization has an Apex trigger on an opportunity that sends updates to the Amount and Quantity
fields into a custom object that calculates commission for each sales rep.

Today, the trigger would only send these updates if the Amount or Qty was directly updated from the Opportunity
record (UI or API). However, if the Amount or Quantity fields were updated as a result of a change to an opportunity
product line item, the trigger on the opportunity would not fire and the details in the commission custom object would
not reflect the changes made to the overall opportunity.

When the New Opportunity Save Behavior is enabled, the triggers on the Opportunity will fire when the opportunity
product changes that roll-up to the Amount or Quantity field. The data in the commissions custom object will reflect
the accurate Amount and Qty values for commission calculations.

Additional Considerations

New Save Behavior When Cloning an Opportunity with Products

With Spring '09, Salesforce is improving the process for cloning an opportunity with products. With this release, save logic
such as triggers, workflow rules, validation rules, etcetera will now execute on the products for an opportunity as well as the
opportunity itself. For more information on the order in which logic is executed, see "Triggers and Order of Execution" in
the Apex Language Reference.

Save logic will run on the opportunity and then on the opportunity products. If errors occur on an opportunity product, you
must return to the opportunity and fix the errors before cloning; you must fix all errors at the opportunity level. Additionally,
if any opportunity products contain unique custom fields, you must null them out using logic in a trigger before cloning the
opportunity.

New Save Behavior When Changing the Opportunity Price Book

If you change the price book associated with an opportunity, all products are deleted from the opportunity. With Spring '09,
opportunity line item delete triggers will run when you change the price book associated with an opportunity.
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New Save Behavior When Performing a Mass Account Owner Change

The account mass transfer process transfers accounts in groups, grouped by the current account owner. An error associated
with the transfer of any account will result in the failure of the group of accounts for that owner; accounts with other owners
will be transferred. An error message will also display at the top of the page.

For example, you are going to mass transfer the following accounts to user D:

• Account1 owned by user A
• Account2 owned by user A
• Account3 owned by user B
• Account4 owned by user B
• Account5 owned by user C

Account3 has an error in the post-trigger and fails to update. Additionally, any other accounts owned by the user of the failing
account will fail. The result of the transfer is as follows:

• Account1 and Account2 transferred to user D
• Account3 and Account4 NOT transferred
• Account5 transferred to user D

Salesforce Mobile Enhancements

Available in: Unlimited and Developer Editions

Available for an additional cost in: Professional and Enterprise Editions

The Spring '09 release includes many new features that improve the capabilities of Salesforce Mobile. These include:

• Device Assignment Security Control
• Mobile Asset Management
• Multi-Relationship Support
• One-Click Installation for BlackBerry
• Actions Toolbar for iPhone
• Log-a-Call Popup for iPhone
• Change Owner for iPhone
• Standard Views for iPhone
• Visualforce Mobile and Mobile Web Tabs for iPhone
• Dashboards for iPhone
• Related Lists on Detail Pages for Windows Mobile
• Related Records Search for Windows Mobile
• Opportunity Contact Roles for Windows Mobile
• Automatic Purging of Searched Records for Windows Mobile
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About Salesforce Mobile Enhancements

Device Assignment Security Control

With Spring '09, administrators have greater control over how mobile users connect to Salesforce. The Device Assignment
Security Control feature permanently links users to their mobile devices. Users cannot register a new device until an administrator
manually deletes their old device in Salesforce.

Linking Users to Devices

User Permissions Needed

"View Setup and Configuration"To view mobile settings:

"Manage Mobile Configurations"To change mobile settings:

By default, Salesforce automatically associates a device record with the mobile user who most recently activated the device, so
administrators do not need to update the device record to assign the device to another user. While this behavior makes it easy
to switch devices between users in your organization, some administrators prefer that users are permanently linked to the
devices they were originally assigned. This helps administrators of organizations with sensitive data ensure that their users do
not access corporate data from personal devices.

This feature can be enabled using the new Mobile Settings node in the setup tree. To customize mobile settings for your
organization:

1. Click Setup ➤ Mobile Administration ➤ Mobile Settings.
2. Click Edit.
3. Select Permanently Link User to Mobile Device to prevent mobile users from registering any mobile device other

than the one they used for their initial Salesforce Mobile account activation.

Note:  If you select the Permanently Link User to Mobile Device checkbox, you must manually delete
the device from a user's record if you want to assign the device to a different user. See "Deleting Mobile Devices"
in the Salesforce online help.

4. Click Save.

Mobile Asset Management

Spring '09 offers mobile support for assets, which is a standard Salesforce object. Now users can access assets and manage cases
with assets from their mobile devices.

To mobilize assets:

1. Click Setup ➤ Mobile Administration ➤ Mobile Configurations, and click the name of the mobile configuration you
want to modify.

2. In the Data Sets related list, click Edit.
3. In the hierarchy, select Data Sets to create a parent data set, or select an existing data set to create a child data set.
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4. Click Add....
5. In the popup window, select Assets.
6. Optionally, use filters to restrict the asset records that the data set includes.
7. Click Done.

The new records synchronize to users' devices at the next incremental update, which occurs approximately every twenty
minutes if the device is connected to Salesforce.

Multi-Relationship Support

Spring '09 extends the flexibility and power of the mobile platform by allowing administrators to define data sets for objects
that have both parent and child relationships with other objects. Now when adding a child data set to your mobile configurations,
the Add a Data Set popup window displays any object with a relationship to the selected object. This includes child objects,
and also parent objects with a master-detail or lookup relationship to the selected object.

For example, assume you created an account field called Primary Contact with a lookup relationship to the contact object. If
you add Account as a top-level data set in a mobile configuration, you see two sets of contacts when you add Contact below
Account:

• Contact: Represents the standard relationship between the account and contact objects.
• Contact (Referenced by Account): Represents any object that is the parent in a lookup or master-detail relationship for

the selected object. In this case, the contact object is referenced by the Primary Contact field on the account object.

This feature gives you greater control over which object records are mobilized when you add an object to a configuration's
data sets. Now that Salesforce distinguishes between these two types of relationships in the Mobile Administration Console,
you could, for example, mobilize just the contacts referenced by a custom account field without sending any child contact
records to the device.

One-Click Installation for BlackBerry

With Spring '09, Salesforce Mobile for BlackBerry is easier to install and upgrade. Previously, the installation required a
two-step process which removed any older versions, then installed the latest. Now the installation and upgrade is a simple
one-step process because version 10.0 and later do not require explicit removal. However, to take advantage of this streamlined
installation, administrators need to upgrade all users on version 9.0 or older to the latest available version prior to the release
of Spring '09.

Note:  Although the installation and upgrade processes have changed in Spring '09, there is no BlackBerry client
release for Spring '09.

To install Salesforce Mobile for BlackBerry:

1. From your BlackBerry smartphone's browser, navigate to the following URL:http://mobile.salesforce.com/setup.
2. Highlight the Click here to download the client link and select Get Link from the menu.
3. Click Download to download the application. If prompted to replace an older version of the client application, click Yes.

Note:  If your device is running version 9.0 or earlier, you must first remove the old version of the client application
before continuing with the installation. From the BlackBerry home screen, click Options ➤ Salesforce Mobile,
then click Uninstall Application.

4. Click Reboot to restart your device.
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5. When prompted to allow an HTTP connection, select the tp.mobile.salesforce.com checkbox. Scroll down and
click Allow this connection.

6. Click the Salesforce Mobile icon, which resides on the home page of your device or in the Applications folder. On newer
phones, the icon may be in the Downloads folder.

7. Read the license agreement and click I Accept.

The Salesforce Mobile Activation page appears.

8. Enter your Salesforce username and password.

Because many passwords contain special characters that are difficult to enter on the device, the Show Password checkbox
is selected by default. To protect your password, deselect the option. An asterisk displays for each character you type.

9. Open the menu and select Activate to verify your Salesforce account and activate Salesforce Mobile on the device.

After your username and password are confirmed by Salesforce, the data is downloaded, and the icon pulses to show activity.
The initial data download may last a few minutes. Future updates to the data occur automatically.

To upgrade Salesforce Mobile for BlackBerry:

1. In the mobile application, open the menu and select System Info.
2. Open the menu and select Upgrade.
3. Click Download to download the installation program.
4. Click Yes to replace the old version of the application.
5. Click Reboot to restart your device.
6. When prompted to allow an HTTP connection, select the tp.mobile.salesforce.com checkbox. Scroll down and

click Allow this connection.
7. Click the Salesforce Mobile icon, which resides on the home page of your device or in the Applications folder. On newer

phones, the icon may be in the Downloads folder.
8. Read the license agreement and click I Accept.

The mobile application opens. Account activation is not required for upgrades.

Actions Toolbar for iPhone

Spring '09 offers an interface enhancement to the mobile client application for the iPhone and iTouch. When you open a
record, a toolbar appears at the top of the detail page. The toolbar displays a set of actions you can take on the current record.

• To hide the toolbar, tap Hide.
• To open the toolbar again, tap Actions.

Note: The toolbar is not available if you have read-only access to the selected record.

Log-a-Call Popup for iPhone

With Spring '09, iPhone users can work more efficiently in the mobile application. The Log a Call feature enables users to
quickly capture calls as events or tasks. When users tap a phone number in Salesforce Mobile to initiate a call or select Log
Call from the actions toolbar, they can easily track who they called and what transpired.

To log calls:
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• If you tapped a phone number in Salesforce Mobile to initiate a call, you are prompted to log the call once the call is
complete. Tap Yes. Your settings control whether or not you are prompted to log the call. For information about changing
when you are prompted to log calls, see Customizing the Call Settings.

• You might not have time to log the call immediately after it ends, or the call might not have been initiated from Salesforce
Mobile. To log the call, open the record, and then tap Log Call on the toolbar. If the toolbar is not visible, tap Actions
to open it.

• Logging a call launches a new task or event so you can enter details about the call. To define whether calls are logged as
tasks or events, customize your settings. See Customizing the Call Settings.

• Tap Save to log the completed task or event to Salesforce. You can see the activity by viewing the activity history associated
with the record.

Customizing the Call Settings

To edit the settings that control how you log calls:

1. From the Home screen of your iPhone or iPod touch, tap Settings.
2. Scroll down and tap Salesforce.
3. Set when you are prompted to log calls placed from the mobile application:

• To be prompted to log each call you place from the mobile application, tap Log Calls, then tap Ask every time.
• To automatically log calls after placing them, tap Log Calls, then tap Always.
• To never be prompted to log calls, tap Log Calls, then tap Never.

4. Set whether calls are logged as tasks or events:

• To automatically log calls as tasks, tap Keep Calls As, then tap Tasks.
• To automatically log calls as events, tap Keep Calls As, then tap Events.

5. Tap Settings to close the Salesforce settings and return to the previous page.

Change Owner for iPhone

Spring '09 provides iPhone and iTouch users with the ability to assign a record in Salesforce Mobile to a different user, subject
to permission rules.

To change the record owner:

1. Select an object to open the list view.
2. Tap the record name.

Note: You can only reassign records that contain a Record Owner field.

3. Tap Change Owner on the toolbar. If the toolbar is not visible, tap Actions to open it.
4. Tap the name of the user to whom you want to assign the record.
5. Tap Save.
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Standard Views for iPhone

In Spring '09, some standard views are available in the mobile client application for iPhone and iTouch. For all objects, you
can view a list of all the records on your phone, or just the records you own.

Note:  Custom views are not currently available in the mobile client application for iPhone.

To select a view:

1. Select an object to open its list view.
2. Tap the name of the current view to open a list of available views for that object. For example, tap My Accounts to open

a list of standard views for accounts.
3. Tap the name of a view to select it.

The application remembers the view you chose and displays it the next time you select that object.

Visualforce Mobile and Mobile Web Tabs for iPhone

Visualforce Mobile and Mobile Web Tabs fill the gap between the limitations of the current “object-only” mobile client
technology and the near-limitless features of the Salesforce desktop application. Using a mobile browser, administrators can
mobile-enable tabs and other features previously available only on the desktop version of Salesforce. This capability greatly
extends the customizability of the mobile application for iPhone.

By creating a Visualforce page and mobilizing it, administrators can create any kind of form or wizard and make it instantly
available as a tab in the mobile application. Administrators can also take advantage of specific features available on mobile
Web browsers.

Note: Visualforce Mobile and Mobile Web Tabs are already available in the mobile client application for BlackBerry.
Spring '09 extends these features to the iPhone.

Enabling Visualforce Tabs for Salesforce Mobile

When you build or edit the Visualforce tab or web tab, select the Mobile Ready checkbox in the wizard to verify that the
website or Visualforce page displays and functions properly on a mobile phone. Selecting the checkbox adds the tab to the list
of available tabs for your mobile configurations. See "Managing Mobile Tabs" in the Salesforce online help for information
on how to mobilize tabs.

To find out more about developing Visualforce pages, see the Visualforce Developer's Guide.

Displaying Visualforce and Web Tabs

Not all tabs in Salesforce Mobile are object tabs. Visualforce tabs and web tabs are also available if they were mobilized by
your Salesforce administrator.

A web tab displays a website. A Visualforce tab displays a page that was developed using Visualforce. Visualforce uses a
tag-based markup language, providing a powerful way to build applications and customize the Salesforce user interface.
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In Salesforce Mobile, selecting a Visualforce tab or web tab launches a web browser that is embedded in the application. While
the mobile client application lets you work with your object data offline, viewing websites and Visualforce pages requires a
network connection.

• Select the Visualforce tab or web tab to display the page. How quickly the page loads depends on the strength of your
wireless signal and the size of the page. Contact your administrator if the mobile browser does not properly display the
page or if important features on the page are not supported.

• To return to the originating URL of a Visualforce tab or web tab, tap Tab Home on the toolbar. If the toolbar is not
visible, tap Actions to open it.

• To reload the current page, tap Refresh on the toolbar.
• To return to the previous page, tap Back on the toolbar.
• To go forward one page, tap Forward on the toolbar.
• To stop a page from loading, tap Stop on the toolbar.

Dashboards for iPhone

Mobile Dashboards are a perfect fit for managers and field employees who want to get a quick peek at their dashboard data
while away from the office.

Administrators can mobilize the Dashboards tab and instantly give users access to all their Salesforce dashboards. Dashboards
are an enormously popular feature in Salesforce, and the opportunity to access this important data while on the move greatly
enhances the power of Salesforce CRM management information.

Note:  Mobile dashboards are already available in the mobile client application for BlackBerry. Spring '09 extends this
feature to the iPhone.

Setting Up Mobile Dashboards

You can make the Dashboards tab available in Salesforce Mobile by adding it to the tabs for a mobile configuration. Mobile
dashboards allow field users to keep up with corporate metrics and key performance indicators even when they do not have
access to a computer.

Note the following about mobile dashboards:

• The Dashboards tab in the mobile application launches an embedded browser to display the dashboards.
• Due to screen size limitations, mobile dashboards display in a single column.
• Links to custom report details are disabled in mobile dashboards.
• The first time a user visits the Dashboards tab in Salesforce Mobile, the mobile application requests the last dashboard

the user viewed on the Salesforce website. Depending on the strength of the cellular or WiFi signal, it could take several
moments before the dashboard displays on the page.

• Dashboards do not automatically refresh in the mobile application. Users can request a dashboard refresh by tapping
Refresh.

• Users are able to work offline in the mobile application. Without a wireless connection, users can see the last viewed
dashboard, but they cannot refresh the dashboard or select a different one.

• The minimum iPhone operating system requirement for mobile dashboards is 2.0.

To enable mobile dashboards:

1. Click Setup ➤ Mobile Administration ➤ Mobile Configurations, and then click the name of a mobile configuration.
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2. In the Mobile Tabs related list, click Customize Tabs to define mobile tabs for the first time. If you have already set up
the mobile tabs, click Edit.

3. Select Dashboards from the Available Tabs list, and click the Add arrow to add it to the mobile configuration. The
Available Tabs list includes standard object tabs, custom object tabs. It can also include web and Visualforce tabs.

Caution:  If you have not yet customized tabs in the mobile configuration, you must select all the tabs that should
appear in the mobile application, not just the Dashboards tab.

4. In the Selected Tabs list, choose the Dashboards tab and click the Up and Down arrows to define where the Dashboards
tab should appear in the mobile application.

5. Click Save.

Working with Salesforce Mobile Dashboards for iPhone

Selecting the Dashboards tab in Salesforce Mobile displays the dashboard you most recently viewed. To view a different
dashboard, choose a dashboard from the View Dashboard drop-down list, and then tap Go. This drop-down list includes
dashboards in all dashboard folders to which you have access.

The data in each dashboard is as current as the date and time displayed in the As of field at the top of the dashboard. To
refresh a dashboard:

1. Tap Refresh on the dashboards page.
2. Wait a few minutes to give the mobile application time to receive the updated information from Salesforce. You can leave

the dashboard and perform other functions in Salesforce Mobile while the data refreshes.
3. Return to the dashboard and tap Reload. You can also reload the page by tapping Actions and then Refresh.

Note: You cannot use the Refresh button on the toolbar to request a dashboard refresh from Salesforce. You can
only use it to view updated data after the refresh has already been submitted.

Related Lists on Detail Pages for Windows Mobile

Spring '09 offers an interface enhancement to the Windows Mobile client application. Now users can access a record's related
items directly from its detail page. The related lists are still available on the Actions menu as well.

To view a record's related items:

1. Open a record.
2. Scroll down to the bottom of the detail page, then select the Related Items header to open a section containing the record's

related lists.

The number of records in each related list displays next to its name.

3. Select one of the related lists to display the records.

Note: In the mobile application, a record's related lists are based on the lookup fields in the object, not on the object's
page layout. For example, you can remove the Accounts related list from the Contact page layout, but the Accounts
related list still displays in contact records in Salesforce Mobile because contact records contain a lookup field to
Account.
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Related Records Search for Windows Mobile

With Spring '09, Windows Mobile users can now quickly search for a record's related items if they are not available on the
device. To search for related items:

1. Open a record, then select a related list.
2. Select Find More.

The mobile application retrieves any related records from Salesforce and displays the search results on the appropriate tab.
For example, if you initiate the search from an account's related contacts list, the results display on the Contacts tab.

3. To download a related item to your device, simply open the item. From the Search Results view, highlight the item and
press ENTER or select Actions ➤ Open.

4. Tap OK or select Options ➤ Close to return to the search results and download additional related items.

The mobile application cannot automatically download all the related items because a large amount of records could force
the device to exceed the total data limit set by your Salesforce administrator.

Opportunity Contact Roles for Windows Mobile

User Permissions Needed

"View Setup and Configuration"To view mobile data sets:

"Manage Mobile Configurations"To create, change, or delete mobile data sets:

In Spring '09, Windows Mobile users can view opportunity contact roles on their devices. To mobilize contact roles, include
the contact role data set as a child of the opportunity data set in your mobile configurations. In the mobile client application,
contact roles are available as a related list on opportunity records.

Note:  Opportunity Contact Roles are already available in the mobile client application for BlackBerry. Spring '09
extends this feature to Windows Mobile.

Automatic Purging of Searched Records for Windows Mobile

In Spring '09, the new data management feature in the Windows Mobile client application helps reduce the amount of memory
used by Salesforce Mobile. Now the mobile client application automatically purges records that the user searched for and
downloaded but no longer accesses. This enhancement can prevent the mobile application from draining valuable device
resources and keeps users from reaching their data size limit too quickly.

Note:  Automatic Record Purging is already available in the mobile client application for BlackBerry. Spring '09
extends this feature to Windows Mobile.
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Additional Salesforce Application Enhancements

Activities Enhancements

Available in: All Editions

Spring '09 includes the following enhancement for activities:

New Time Picker for Events
When creating or editing an event, users can now select start and end times from a drop-down list instead of having to
manually enter the time. The drop-down list displays time in half-hour increments. When a user changes the start time,
the end time automatically adjusts based on the original duration of the event.

Case Enhancements

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Spring '09 includes the following enhancements for cases:

Show Closed in Case Status Field Setting
Now, administrators can add Closed to the Status field on cases so that users can close cases without having to click
the Close Case button and update information on close case page layouts. Administrators can significantly reduce the
number of clicks it takes for users to close cases by clicking Setup ➤ Customize ➤ Cases ➤ Support Settings ➤ Edit
and selecting Show Closed in Case Status Field. Additionally, after administrators select Show Closed in
Case Status Field, they can select Hide Save & Close Button so that the Save & Close button does not
needlessly appear on case edit pages when cases can be closed via the Status field and Save button.

Selecting the Show Closed Statuses in Case Status Field checkbox does not remove the Close button from
case list views; however, it does add Closed to the list of statuses available for users to choose from when they select
multiple cases and click Change Status on case list views. For more information, see "Viewing Case Lists" in the Salesforce
online help.

"Modify All Data" Permission Now Includes "Delete" Permission on Cases
Previously, the "Modify All Data" permission did not include the "Delete" permission on cases. Now, when you select
"Modify All Data" on a user profile, "Delete" on cases is automatically set on the profile. Furthermore, if you deselect
any permissions on cases, the "Modify All Data" permission is automatically deselected. For more information, see
"Creating and Editing Profiles" in the Salesforce online help.

Case Team Enhancements

Available in: Enterprise, Unlimited, and Developer Editions

Spring '09 includes the following enhancements for case teams:

Replace Case Team Roles
Now, users with the "Customize Application" permission can replace an existing case team role and globally replace a
role in all existing cases:
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1. Click Setup ➤ Customize ➤ Cases ➤ Case Teams ➤ Case Team Roles.
2. Click Replace next to the name of the case team role you wish to replace.
3. Choose a case team role with which to replace the existing role.
4. Click Save.

Note that if your organization has only one case team role, you cannot replace it.

Report on Case Teams
Now, you can report on case teams in which you are a member. After you run a case report, simply select My team's
cases from the View filter. For more information, see "Running Reports" in the Salesforce online help.

Enhanced User Interface for Case Teams
Now, an enhanced user interface makes it even easier to add and update case team members to the Case Team related
list and predefined case teams.

CTI Support for Firefox

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Now, version 1.50 of the Salesforce CRM Call Center CTI adapter is available for use with the Firefox 3.0.+ Web browser.
The CTI adapter will only work for Firefox when vendors update their distributions to use the latest CTI Toolkit. For more
information about the CTI adapter, see CTI Toolkit Developer's Guide. To download the CTI adapter from salesforce.com,
visit the Force.com AppExchange.

Salesforce CRM Call Center seamlessly integrates Salesforce with third-party computer-telephony integration (CTI) systems.
After a lightweight CTI adapter program has been installed on a Salesforce user's machine, the user can use the features of a
CTI system through the Salesforce SoftPhone, a customizable call control tool that appears in the sidebar of every Salesforce
page.

Case Auto-Response Rule Enhancements

Now, when a case auto-response rule is triggered by an incoming email or Web-to-Case, the incoming email is added to the
Activity History related list on the case's contact and the Email related list on the case. Previously, the incoming email was
only added to the Activity History related list on the contact.

Email-to-Case Enhanced Email Address Matching

Available in: Professional, Enterprise, Unlimited, and Developer Editions

In Spring '09, Email-to-Case now matches users' email addresses with contacts in Salesforce regardless of case. For example,
if the From field in an Email-to-Case submission is Jane.Doe@yourcompany.com and Jane's email address on her Salesforce
contact record is jane.doe@yourcompany.com, the new case is associated with Jane's contact record.

Spring '09 also introduces Email-to-Case as a Service. For more information, see Email-to-Case as a Service on page 24.
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Search the Full Text of a Document in the Documents Tab

Available in: All Editions

Spring '09 introduces the ability to perform a full-text search of a document in the Documents tab. When a new document
is uploaded or an old one is replaced, its contents are available as search terms to retrieve the document.

To search the contents of a document:

1. Click the Documents tab.
2. Enter your search terms. Salesforce performs a full-text search of the document's contents, and also searches the following

fields:

• Document Name

• Keywords

• Description

• Type

3. Click Find Document. The search returns a list of documents that match all your search terms. The search results are
listed in order of the closest matches.

Salesforce automatically determines if the contents of a document can be searched. If the Document Content Searchable
property is checked on a document, then its contents have been processed successfully and can be searched. If your document
is large, it may take several minutes before Salesforce processes the contents of the document and marks the Document
Content Searchable property.

The following file types are supported for a document content search:

HTML (only the text within a <body> tag)
.htm, .html, .xhtml

PDF
.pdf

PPT
.pot, .pps, .ppt

RTF
.rtf

Text
.c, .cpp, .css, .csv, .ini, .java, .log, .sql, .txt

Word
.doc, .dot

XLS
.xls, .xlt

XML
.xml

In some instances documents are not searched. These include:
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• If a file extension is changed to a different format, it is not searched, even if both extensions are valid. For example, a .txt
file that is renamed to .rtf is not searched.

• PDF and Word documents may have security restrictions that prevent them from being searched. To ensure that the
content is searchable, the "content extraction" property on your file must be set to "Enabled" when creating your document.

Salesforce CRM Ideas Enhancements

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Spring '09 includes the following enhancements for Salesforce CRM Ideas:

Suggested Duplicates for Ideas
To prevent users from posting duplicate ideas to a community, Salesforce now automatically searches for similar ideas
as soon as a user enters the title of a new idea he or she wants to post. Salesforce then displays a list of possible duplicates
so the user can decide if the idea has already been posted to the community. If a similar idea has already been posted,
the user can click that idea's title to open the detail page and vote for the idea.

New Visualforce Controllers and Components (Limited Release)
Salesforce CRM Ideas includes two new controllers and three new components that are currently available through a
limited release program. For more information, see Visualforce Enhancements on page 90.
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FORCE.COM PLATFORM

Enhanced Page Layout Editor

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

With Spring '09, Salesforce introduces a new way to create page layouts: the enhanced page layout editor.

The enhanced page layout editor is a feature-rich WYSIWYG tool that allows you to customize your organization’s page
layouts for detail and edit pages in Salesforce, the Self-Service Portal, and the Salesforce Customer Portal. The enhanced page
layout editor provides all of the functionality of the original page layout editor, as well as additional functionality and an
easier-to-use interface.

Differences from the Original Page Layout Editor

The following table describes how certain actions in the original page layout editor are different in the enhanced page layout
editor.

Enhanced Page Layout EditorOriginal Page Layout EditorAction or Feature

Drag a blank space from the paletteNot availableAdd blank spaces

Click Layout PropertiesOn the layout edit pageAccess object-specific settings, such as
the "Show Case Assignment"
checkbox on the Case page layout

Click Layout PropertiesSelect Header Items from the View
drop-down list, and drag the Personal

Enable tagging for a specific page layout

Tags or Public Tags items to the Header
Section of the layout.

Drag a section element from paletteClick Create New SectionAdd a new section

Drag a button from palette or click the
red X icon that is visible when hovering
over an element

Click the Detail Page Buttons sectionAdd a detail page button

Drag the element to the palette or by
click its delete icon

Select the element and click DeleteDelete an element

Click the wrench icon that is visible
when hovering over an element

Click Edit PropertiesEdit the properties of an element

Click Save As on the layoutClick Clone on the layout detail pageClone a layout

Click Mini Console ViewClick Related ObjectsSelect the parent objects for your object
so that you can display them in the
console

Click Yes on the Overwrite Users'
Personal Related List Customizations

Select the Overwrite Users'
Personal Related List

Overwrite users' personal related list
customizations (Professional, Enterprise,
Unlimited, and Developer Edition only) popup window, which appears when

saving a page layout if you moved or
added a related list

Customizations checkbox above the
related list section
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Implementation Tips

• The enhanced page layout editor supports the following browsers:

- Firefox, version 3.0.x

Note:  Users with the "View Setup" permission can view but not edit page layouts using Firefox, version 2.
Users with the "Customize Application" must have Firefox, version 3.0.x to view the page layout.

- Internet Explorer, versions 6 and 7
- Safari for Mac OSX, version 3.1

• Enabling the enhanced page layout editor is an organization-wide preference. Administrators using the Firefox browser
should upgrade to Firefox, version 3.0.x before the Spring '09 release.

• Salesforce gives administrators the option to view a short video tutorial the first time they access the enhanced page layout
editor. This video is also available from the Video Tutorial link next to the Help for this Page link in the editor.

Best Practices

• Click the Edit Layout link on detail pages to quickly access the page layout editor. After modifying the layout, click Save
to return to the detail page to see your changes applied.

• When you select a category of elements on the palette, such as Related Lists or Custom Links, Salesforce jumps to the
part of the page layout where you can add those elements.

• Collapse the palette to gain vertical space when working on moving items around within the page layout.
• Use blank spaces to visually align and distinguish elements on the page.

About the Enhanced Page Layout Editor

Customizing Page Layouts with the Enhanced Page Layout Editor

Available in: All Editions

User Permissions Needed

"Customize Application"To customize page layouts:

"View Setup"To view page layouts:

The enhanced page layout editor is a feature-rich WYSIWYG tool that allows you to customize your organization’s page
layouts for detail and edit pages in Salesforce, the Self-Service Portal, and the Salesforce Customer Portal. The enhanced page
layout editor provides all of the functionality of the original page layout editor, as well as additional functionality and an
easier-to-use interface.

Note: The enhanced page layout editor is enabled by default for all organizations. If you want to use the original page
layout editor, you can enable it for your organization instead of the enhanced page layout editor. See "Customizing
User Interface Settings" in the Salesforce online help. Your organization can only use one of the page layout editors
at a time.
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Users with the "Customize Application" permission can view and customize page layouts in the enhanced page layout editor
as follows:

• For standard object page layouts, select Setup ➤ Customize, select the object, and choose the Page Layouts link. In
Enterprise, Unlimited, and Developer Edition organizations, click Edit next to the page layout you want to customize.

• For custom object page layouts, select Setup ➤ Create, select the object, and scroll to the Setup ➤ Customize section.
In Enterprise, Unlimited, and Developer Edition organizations, click Edit next to the page layout you want to customize.

• For standard and custom object page layouts, navigate to the page you want to edit and click the Edit Layout link located
in the upper right corner of the page layout. Salesforce displays the Edit Layout link only to users with the "Customize
Application" permission.

Tip: Click the Edit Layout link on detail pages to quickly access the page layout editor. After modifying the
layout, click Save to return to the detail page to see your changes applied.

Users with the "View Setup" permission can view a page layout in the enhanced page layout editor as follows:

• For standard object page layouts, select Setup ➤ Customize, select the object, and choose the Page Layouts link. In
Enterprise, Unlimited, and Developer Edition organizations, click the name of the page layout you want to view.

• For custom object page layouts, select Setup ➤ Create, select the object, and scroll to the Page Layouts section. In
Enterprise, Unlimited, and Developer Edition organizations, click the name of the page layout you want to view.

Tip:  If you are viewing or customizing an object that has multiple page layouts, you can quickly access the other
layouts by clicking the page layout name at the top of the page and selecting another layout to view.

The enhanced page layout editor consists of two parts: a palette on the upper portion of the screen and the page layout on the
lower portion of the screen. The palette contains the user interface elements, such as fields, buttons, links, related lists, and
any additional elements that are available for you to add to the page layout.

• To add a user interface element to the page layout, select the category to which the element belongs on the left column of
the palette, and drag the element from the palette to the page layout.

• To remove a user interface element from the page layout, drag the element from the page layout to the right side of the
palette, or click the x icon ( ) next to the element.

When working with user interface elements, note the following:

• You can use CTRL+click to select multiple elements individually and SHIFT+click to select multiple elements as a group.
• You can change the properties of any element on the page layout by double-clicking the element or clicking the wrench

icon ( ) next to it. You cannot change the properties of elements in the palette.
• Some elements can only be moved to certain locations on the page layout.
• Elements that are already on the page layout still appear on the palette but are inactive. When you click an inactive element

on the palette, Salesforce highlights the element on the page layout.
• When you select a category of elements on the palette, such as Related Lists or Custom Links, Salesforce jumps to the

part of the page layout where you can add those elements.
• Collapse the palette to gain vertical space when working on moving items around within the page layout.

The following list describes the user interface elements and how you can use them in your page layout:

Blank Spaces

You can add and move blank spaces to any section on the page layout. Use blank spaces to visually align and distinguish
elements on the page.
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To add a blank space, drag the Blank Space user interface element from the palette to the desired location on the page
layout. The Blank Space user interface element is the first option in the palette when you select the Fields, Custom
Links, Custom S-Controls, or Visualforce Pages category on the palette.

Note:  If you use the original page layout editor to view a page layout that was created in the enhanced page
layout editor, the original page layout editor will show any blank spaces you added. You cannot move or add
blank spaces in the original page layout editor, but you can remove them by dragging them to the box on the
right.

Buttons

The top of the page layout has a place for standard buttons and another for custom buttons. You can control which
standard and custom buttons are displayed and the order in which the custom buttons appear; however, you cannot
rearrange the order in which the standard buttons appear.

To add a custom or standard button to the page layout, select the Buttons category on the palette and drag one or more
buttons from the palette to the buttons section on the page layout. Standard buttons must go in the standard buttons
area, and custom buttons must go in the custom buttons area.

To remove a standard or custom button from the page layout, drag the button to the palette.

For information on buttons in related lists, see Related Lists below.

Tip:  Create the appropriate buttons before editing your page layout. For example, create an account custom
button for the detail page and a contact custom list button before putting them both on an account page layout.
For implementation tips and best practices on custom buttons, see Custom Button Considerations.

Custom Links

To add custom links to the page layout, select the Custom Links category on the palette and drag one or more custom
links from the palette to the Custom Links section on the page layout.

To remove a custom link from the page layout, drag the custom link to the palette.

Tip:  Create the appropriate links before editing your page layout. See "Defining Custom Buttons and Links"
in the Salesforce online help.

Fields

To add fields to the page layout, select the Fields category on the palette and drag one or more fields from the palette
to any section on the page layout, except for sections reserved for custom buttons or links and related lists.

A field might display one or more of the following icons:

•  The field must have a value to save the record but is not required on the page layout itself.
•  The field must be included on the page layout because either an administrator configured the field as universally

required or Salesforce automatically requires the field. Although you cannot remove such fields, you can move them
to different locations.

•  The field is a controlling field.
•  The field is a dependent field.
•  The field is read only.
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To set which fields are required and read only, select one or more fields and click the wrench icon ( ) on any of the
selected fields.

• The field properties of some standard fields cannot be changed. Custom fields can only be changed if they are not
universally required fields.

• Fields marked as read only are always editable by administrators and users with the "Edit Read Only Fields" permission.
• If you make a picklist field read only, all new records will contain the default value for that picklist.
• Auto-number fields are always read only.
• If you mark the opportunity Probability field as read only, the Probability value will still be updated

automatically when a user changes the Stage value of an opportunity.

When working with fields, note the following:

• In Personal, Group, and Professional Editions, page layouts control which fields users can access in related lists, list
views, reports, Connect Offline, email and mail merge templates, custom links, and when synchronizing data. In
Enterprise, Unlimited, and Developer Editions, this access is controlled by field-level security. Field-level security
settings override any field properties you set on the page layout if the field-level security is more restrictive than the
page layout setting. See "Setting Field-Level Security" in the Salesforce online help.

• In the organization-wide import wizards for accounts, contacts, and leads, administrators have access to import into
any field, even if a field is hidden or read only in their page layout or field-level security settings. Individual users can
import only into the fields that are accessible to them via their page layout or field-level security settings.

• For information on setting which fields display for users in search results, see "Customizing Search Layouts" in the
Salesforce online help.

Related Lists

To add related lists to the page layout, select the Related Lists category on the palette and drag one or more related lists
from the palette to the desired location on the page layout. A page layout can have up to 100 related lists.

You can place related lists at the bottom of the page layout. To move a related list on the page layout, drag the handle
located above the related list.

To customize a related list, double-click the related list handle or click the wrench icon ( ) inside the handle. Use the
related list properties to:

• Specify which fields display as columns on the related list, the order in which they appear, and the sort order of the
records in the related list. In Professional, Enterprise, and Unlimited Editions, you can also opt to apply the column
information to other page layouts for the same type of object.

• Specify which standard and custom buttons appear on the related list.

When working with related lists on page layouts, note the following:

• Some related lists are not customizable because they link to data rather than store it. Salesforce denotes related lists
that are not customizable on the page layout.

• You cannot add related lists to the page layouts for the User object.
• You can also enable related list hover links for your organization so that record detail pages include links for each

related list at the top of the page. Users can hover the mouse over a related list hover link to display the corresponding
related list in an interactive overlay that allows users to quickly view and manage the related list items. Users can also
click a related list hover link to jump down to the content of the related list without having to scroll down the page.
To enable related list hover links, see "Customizing User Interface Settings" in the Salesforce online help.
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• In Professional, Enterprise, Unlimited, and Developer Edition, individual users can customize which related lists
display for their personal use. Administrators can overwrite these user customizations and apply the related list
configuration in the page layout to all users, even if they already customized their display. To overwrite users' related
list customizations, click Yes on the Overwrite Users' Personal Related List Customizations popup window, which
appears when saving a page layout if you moved or added a related list.

Custom S-Controls

To add s-controls to the page layout, select the Custom S-Controls category on the palette and drag one or more
s-controls from the palette to any section on the page layout, except for sections reserved for custom buttons or links
and related lists. A page layout can have up to 20 s-controls.

To change the properties of an s-control, double-click the s-control or click its wrench icon ( ) and set the following
attributes:

• Width sets the horizontal size in pixels or a percent.
• Height sets the vertical size in pixels.
• Show scrollbars determines whether the iFrame in which the s-control displays contains scrollbars when necessary.
• Show label determines whether the page layout includes the Label of the custom s-control. Remove the label to

display the s-control in a wider area.

Sections

You can add and move sections anywhere above the related lists on the page layout. The sections you add can contain
fields, s-controls, and blank spaces. In addition, each page layout has a default section that can only contain custom links
and blank spaces. You can change the location of the custom link section, but you cannot remove it from the page.

To add a section, drag the Section user interface element from the palette to the desired location on the page layout.
The Section user interface element is the second option in the palette when you select the Fields or Custom S-Controls
category on the palette.

To change the attributes of a section, double-click the section or select its associated wrench icon ( ). You can:

• Enter a name for the section. Note that names of some standard page sections cannot be changed.
• Specify whether the section should have one or two columns.
• Specify the order in which users will be able to tab through the items in that section.
• Specify whether the section heading should be shown on the detail and edit pages.

Tags

If tags are enabled in your organization, click Layout Properties and use the checkboxes to indicate whether personal
and public tags should be included in the header section of the page layout. Users cannot tag a record if neither personal
nor public tags are included in the header section. Also, the positioning of personal and public tags in the header cannot
be modified.

For more information, see "About Tagging" in the Salesforce online help.

Visualforce Pages

To add Visualforce pages to the page layout, select the Visualforce Pages category on the palette and drag one or more
Visualforce pages from the palette to any section on the page layout, except for sections reserved for custom links and
related lists. A page layout can have up to 20 Visualforce pages.
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You can add a Visualforce page to a page layout only if the standard controller on the Visualforce page is set to the object
for which you are creating the page layout. If you do not have any Visualforce pages with a standard controller set to
that object, the Visualforce Pages category does not appear in the palette.

In addition to the user interface elements listed above, the palette also contains the following features:

Layout Properties

Click Layout Properties to change the name of the page layout, add personal and public tags if available, and display
standard object checkboxes on the page layout. For a complete list of standard object checkboxes, see "Notes on the
Enhanced Page Layout Editor" in the Salesforce online help.

Preview As

Click Preview As to review the page layout. From the preview in Enterprise, Unlimited, and Developer Editions, select
a profile to see how the pages will look for users with different profiles. Note that most related lists’ columns preview
without data.

Note:  For information on specifying which page layouts display for different profile and record type combinations
in Enterprise, Unlimited, and Developer Editions, see "Assigning Page Layouts" in the Salesforce online help.

Quick Find

Use the Quick Find box to quickly locate any item in the palette.The Quick Find box is especially useful for page layouts
that have large numbers of items available in the palette.

Quick Save

Click Quick Save to save your changes and continue editing the page layout.

Save and Save As

Click Save to save your changes when you are done customizing the page layout. If you navigate away from your page
layout before clicking save, your changes will be lost.

To create a copy of your page layout, click Save and select Save As.

Mini Console View

Click Mini Console View to choose which related records display in the console's mini view. (Available in Professional,
Enterprise, Unlimited, and Developer Edition organizations only.)

Note: You cannot choose Mini Console View for the Close Case Layout or the Log a Case Page and View
Cases Page layouts on the Self-Service Portal.

Mini Page Layout

Click Mini Page Layout to define the mini page layouts of the records that appear in the mini view of the console. The
mini page layout also defines the layout of the hover details and event overlays. (Available in Professional, Enterprise,
Unlimited, and Developer Edition organizations only.)

Note: You cannot define mini page layouts for the Close Case Layout or the Log a Case Page and View Cases
Page layouts on the Self-Service Portal.
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Notes on the Enhanced Page Layout Editor

• The enhanced page layout editor supports the following browsers:

- Firefox, version 3.0.x

Note:  Users with the "View Setup" permission can view but not edit page layouts using Firefox, version 2.
Users with the "Customize Application" must have Firefox, version 3.0.x to view the page layout.

- Internet Explorer, versions 6 and 7
- Safari for Mac OSX, version 3.1

• If the original page layout editor is enabled, users can click on the page layout name to access the detail page of the page
layout. The enhanced page layout editor does not have detail pages, as all the detail page functionality is always available
on the enhanced editor. Salesforce displays a read-only version of the enhanced page layout editor to users with the "View
Setup" permission.

Note: The read-only view of the page layout does not display field types and lengths in hover details.

• Use the undo and redo buttons to step backwards and forwards, respectively.
• The following keyboard shortcuts are available:

- Undo = Ctrl+Z
- Redo = Ctrl+Y
- Quick Save = Ctrl+S

• To switch to a different page layout for the same object, click the name of the current page layout in the upper right corner
and select the layout you want to view.

• Some standard objects have checkboxes that are specific to page layouts for that object. The following table lists those
standard object checkboxes.To configure how Salesforce displays the checkboxes, click Layout Properties when customizing
the page layout. Use the Select by default checkbox associated with a checkbox if you want Salesforce to automatically
select the option when a user accesses the edit page.

CheckboxesObject

Case - Case assignment checkbox — Displays the Assign
using active assignment rules checkbox on case
edit pages.

- Email notification checkbox — Displays the
Send notification email to contact checkbox
on case edit pages.

Case Close - Solution information section — Displays the
solution information section on the case close edit pages.

- Notify Contact — Displays the Notify Contact
checkbox on case close edit pages.

Lead assignment checkbox — Displays the Assign
using active assignment rule checkbox appears on
the lead edit page.

Lead
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"Run territory assignment rules on save"
checkbox — Displays the Run territory assignment

Person Account

rules on save checkbox appears on the person account
edit page.

Email notification checkbox — Displays the Send
Notification Email checkbox appears on the task edit
page.

Task

Note:  A user's personal preference for defaulting
the state of the checkbox takes precedence over the
organization-wide setting. For more information,
see "Creating Tasks" in the Salesforce online help.

• The Custom Links, Custom S-Controls, and Visualforce Pages categories only appear in the palette if you have defined
those types of elements for the object for which you are defining a page layout.

• Page layouts for the user object only include custom fields, custom links, s-controls, and Visualforce pages.Tagging, related
lists, custom buttons, and standard field customizations are not included on page layouts for the user object. Also, field-level
security is only available for custom fields on the user object.

• You can define mini page layouts for the user object; however, you cannot add standard fields or related lists. Also, a
customized mini page layout will not display in the console. For more information, see "Defining Mini Page Layouts" in
the Salesforce online help,

• When editing a person account page layout:

- If you add Shipping Address next to Billing Address in the Address Information section, a link will display
on the person account edit page that allows you to copy the billing address to the shipping address. Also, an equivalent
link appears if you add Other Address to the Address Information section.

- Contact fields and related lists are available on person account page layouts. However, contact custom links and custom
buttons are not available.

• Salesforce gives administrators the option to view a short video tutorial the first time they access the enhanced page layout
editor. This video is also available from the Video Tutorial link next to the Help for this Page link in the editor.

Delegated Data Administration

Available in: Enterprise, Unlimited, and Developer Editions

Spring '09 introduces two new object-level permissions that override sharing rules and settings, allowing for delegated
administration of the records associated with a given object:

• View All—users can view all records associated with this object, regardless of sharing settings
• Modify All—users can read, edit, delete, transfer, and approve all records associated with this object, regardless of sharing

settings

The "View All" and "Modify All" permissions ignore sharing rules and settings, allowing administrators to quickly grant access
to records associated with a given object across the organization. "View All" and "Modify All" are for delegated administrators
who are responsible for managing the records belonging to a given object, while the global permissions "View All Data" and
"Modify All Data" are for the administrator of your entire organization. Tasks where these permissions may be applicable
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include data cleansing, deduplication, mass deletion, mass transferring, and managing record approvals. If providing the "View
All Data" or "Modify All Data" administrative permission is too permissive for a particular profile, consider using the "View
All" or "Modify All" object-level permission to restrict data access and management on an object basis. For more information,
see "Comparing Security Models" in the Salesforce online help.

Note: To delegate some user administration and custom object administration duties, you can define delegated
administrators. For more information, see "Delegating Administrative Duties" in the Salesforce online help.

Implementation Tips

To apply the "View All" and "Modify All" permissions:

1. Click Setup ➤ Manage Users ➤ Profiles.
2. Click New, or click Edit for an existing custom profile.
3. In the Profile Edit page, scroll to Standard Object Permissions or Custom Object Permissions.

When using the delegated data administration permissions, be aware of the following considerations:

Permissions

• When you enable "View All" for an object, "Read" is automatically enabled for the object.
• When you enable "Modify All" for an object, "Read," "Edit," and "Delete" are also enabled for the object.
• With "View All" or "Modify All," a user has access to the entire object; access is not segmented based on record type,

region, business unit, or any other segmentation. "Create" is not required, but you can enable it for a profile with
"Modify All."

• By enabling "View All" or "Modify All" on a child detail object in a master-detail relationship, the parent object(s)
also receive "View All" in order to optimize reporting joins. For example, "View All" on assets automatically grants
"View All" on accounts.

• To view record access, click the Sharing button on a record. Any user with "Modify All" is listed as an administrator
with full access, and any user with "View All" is listed as an administrator with read-only access.

Recycle bin
With "Modify All," users cannot undelete recycle bin items that they did not own or did not delete—"Modify All Data"
is still required.

Cloning

• Users with "Modify All" on opportunities, cases, or contacts cannot clone the record unless they have sharing access
to the account or "View All" on accounts.

• If a user does not already have sharing access, then the minimum required permission to clone an opportunity is
"View All" on accounts when he or she has "Modify All" on opportunities. Otherwise, a user can clone an opportunity
only if he or she also has sharing access to the opportunity's account.

Activities
Access to activities is granted by the General User Permissions "Edit Event" and "Edit Task," not by object-level
permissions. Thus, it is not possible to have "Modify All" or "View All" on an activity (an event or task). If the
organization-wide default for activities is set to Controlled by Parent, then users can access activities under the following
conditions:

• Users can view an activity if they have "View All" on the object associated with the parent record.
• Users can edit an activity if they have "Modify All" on the object associated with the parent record.
• Users can delete an activity if they have "Modify All" on the object associated with the parent record.
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Notes
Notes, which can be made private, can be owned by a different record owner than the parent. "Modify All" and "View
All" on the parent record automatically provide access to all notes and attachments, regardless of whether the note or
attachment is owned by someone else or is private. For example, if an account in a private sharing model is transferred
with a private note and the original owner can no longer access the account after transfer, then neither the original
account owner nor the new account owner can access the note. However, a user with "Modify All" or "View All" on
accounts can retrieve the note.

Merging and "View All"
It is possible for a user to have the "Read," "Create," "Edit," "Delete," and "View All" permissions on an object. This
means that the user can view all records, but only edit or delete those records to which he or she has full access via sharing.

• Users with these permissions cannot merge records unless they have full access to the records they are merging.
• "Modify All" is required to have full access across all records for a given object.

Managing documents
"Modify All" on documents allows access to all shared and public folders, but not the ability to edit folder properties or
create new folders. To edit folder properties and create new folders, users must have the "Manage Public Documents"
permission.

Availability

• "View All" and "Modify All" are not available for ideas, price books, and products.
• "View All" and "Modify All" are not available in Customer Portal and Partner Portal profiles.

Best Practices

The delegated data administration permissions are useful when you want to avoid giving the "Modify All Data" or "View All
Data" administrative permissions to users, but you do need to give users the ability to modify or view all data for a given object.
The following are common scenarios for using delegated data administration permissions:

• Use "View All" to enable search or reporting on all the records for a given object.
• Use "Modify All" for an object to handle typical data administrator tasks such as cleaning up data, exporting, transferring,

merging, sharing, and administering workflow approvals by unlocking, editing, and approving records that are locked.
• Use "Modify All" for objects that do not support Full Access sharing.
• Use "Modify All" to unlock approvals for users who need to modify a record before resubmitting (such as for IT help desk

cases).
• Use "Modify All" to transfer any record to a new owner. For example, grant "Modify All" to a territory manager responsible

for aligning territories.
• Create an application administrator profile, and grant "Modify All" and "View All" for all of the relevant objects in a

particular application. For example, this would be useful for a sales user who also needs to administer records in the Time
Off Manager application.

• Use "Modify All" to give sharing access to additional team members.

If you are not sure whether to use the basic object-level permissions in conjunction with the sharing model, or the delegated
data administration permissions, refer to the following guidelines:

• Use the "Read," "Create," "Edit," and "Delete" permissions in conjunction with the sharing model when:

- You want to provide end-user access to records.
- You want to give users assigned to a particular profile access to some, but not all, records.
- You want to be able to respect different sharing access levels—such as Private, Read-Only, Read/Write, and

Read/Write/Transfer/Full Access—for different users or groups.
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- You want to provide record-level access using sharing settings based on the role hierarchy, queues, teams, or groups.

• Use the "Modify All" and "View All" permissions when:

- You want to provide delegated administration access to records.
- You want to easily override sharing settings for a given object.
- You want to provide full access to records for a given object.
- You want to provide access to private records, such as contacts, opportunities, and notes and attachments.
- You want to give users the ability to transfer any records for a given object.
- You want to give users the ability to manually share any record for a given object, not just the records they own, without

having to own the record or be above the owner in the role hierarchy.
- You want to give users the ability, by object, to approve submitted records, or edit and unlock approvals on submitted

records.

About Delegated Data Administration

Standard and Custom Object Permissions

For each type of data, you can specify the following user permissions. These permissions either respect the sharing model, or
override sharing:

Object-Level Permissions that Respect Sharing

• Read—users can only view records of this type
• Create—users can read and create records
• Edit—users can read and update records
• Delete—users can read, edit, and delete records

Note:  By default, most standard profiles have "Create," "Read," "Edit," and "Delete" permissions on every
custom object. However, the Read Only standard profile has only the "Read" permission enabled on every custom
object.

Object-Level Permissions that Override Sharing for Delegated Data Administration

• View All—users can view all records associated with this object, regardless of sharing settings
• Modify All—users can read, edit, delete, transfer, and approve all records associated with this object, regardless of

sharing settings

"Modify All" on documents allows access to all shared and public folders, but not the ability to edit folder properties or
create new folders. To edit folder properties and create new folders, users must have the "Manage Public Documents"
permission.

"View All" and "Modify All" are not available for ideas, price books, and products.

The "View All" and "Modify All" permissions ignore sharing rules and settings, allowing administrators to quickly grant access
to records associated with a given object across the organization. "View All" and "Modify All" are for delegated administrators
who are responsible for managing the records belonging to a given object, while the global permissions "View All Data" and
"Modify All Data" are for the administrator of your entire organization. Tasks where these permissions may be applicable
include data cleansing, deduplication, mass deletion, mass transferring, and managing record approvals. If providing the "View

70

Force.com Platform



All Data" or "Modify All Data" administrative permission is too permissive for a particular profile, consider using the "View
All" or "Modify All" object-level permission to restrict data access and management on an object basis. For more information,
see "Comparing Security Models" in the Salesforce online help.

Note: To delegate some user administration and custom object administration duties, you can define delegated
administrators. For more information, see "Delegating Administrative Duties" in the Salesforce online help.

If your organization has deployed Salesforce Mobile, you can prevent mobile users from creating, editing, and deleting records
in the mobile application, regardless of their standard object permissions in Salesforce. For more information, see "Editing
Mobile Object Properties" in the Salesforce online help.

Comparing Security Models

Available in: Enterprise, Unlimited, and Developer Editions

Salesforce user security is an intersection of both sharing and profile permissions. In some cases, such as in end-user record
level access, it is advantageous to use sharing to provide access to records. In other cases, such as when delegating record
administration tasks like transferring records, cleansing data, deduplicating records, mass deleting records, and delegating
workflow approval processes, it is advantageous to override sharing and use profiles to provide access to records.

In profile permissions for standard and custom objects, the "Read," "Create," "Edit," and "Delete" object-level permissions
respect sharing settings, which control access to data at the record level. The "View All" and "Modify All" object-level
permissions override sharing settings.

The following table describes the differences between the security models.

Permissions that Override SharingPermissions that Respect Sharing

Delegated data administratorsEnd-usersTarget audience

"View All" and "Modify All""Read," "Create," "Edit," and "Delete"
object-level permissions on profiles;

Sharing settings

Where managed

"View All" and "Modify All"Private, Read-Only, Read/Write,
Read/Write/Transfer/Full Access

Record access levels

Available on all objects with "Modify
All"

Respects sharing settings, which vary by
object

Ability to transfer

Available on all objects with "Modify
All"

NoneAbility to approve records, or edit and
unlock records in an approval process

Available on all objects with "View All"Available with a sharing rule that states:
the records owned by the public group

Ability to report on all records

"Entire Organization" are shared with a
specified group, with Read-Only access
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Permissions that Override SharingPermissions that Respect Sharing

Available on most objects in the Standard
Object Permissions and Custom Object
Permissions sections of Profiles

Available on all objects except products,
documents, solutions, ideas, notes, and
attachments

Object support

Note: "View All" and "Modify
All" are not available for ideas,
price books, and products.

ProfileRoles, Roles and Subordinates, Internal
Roles and Subordinates, Queues,Teams,
and Public Groups

Group access levels determined by

Available on private contacts,
opportunities, and notes and attachments
with "View All" and "Modify All"

Not availablePrivate record access

Available on all objects with "Modify
All"

Available to the record owner and any
user above the record owner in the role
hierarchy

Ability to manually share records

Analytics Enhancements

Available in: All Editions

Spring '09 provides several enhancements to Salesforce analytics:

Summary Data Snapshots

Previously, analytic snapshots could only be created using tabular reports. In Spring '09, you can use summary reports
to create analytic snapshots.

Analytic snapshots created using summary reports allow you to specify the grouping level at which summary data is
extracted from the source report.To create an analytic snapshot, click Setup ➤ Data Management ➤ Analytic Snapshots
➤ New Analytic Snapshot. When specifying the Source Report, select a summary report.

Data Grouping Functions

In Spring '09, two new functions are available to use for custom summary formulas for summary reports:
PARENTGROUPVAL and PREVGROUPVAL.

PARENTGROUPVAL

A summary function that returns the value of the selected
summary field from the parent grouping level that you

Description:

specify. Parent grouping levels are those above the
grouping level where you chose to display the formula.
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For matrix reports, choose both row and column
grouping levels.

PARENTGROUPVAL(summary_field,
grouping_level) and replace summary_field

Use:

and grouping_level with the expressions you want
evaluated.

TOTAL_PRICE:SUM/PARENTGROUPVAL(TOTAL_PRICE:SUM,
GRAND_SUMMARY)

Example:

This custom summary formula calculates the size of one
product compared to other products for a report on
opportunities and their products, grouped by product
name.

PREVGROUPVAL

A summary function that returns the value of the selected
summary field from the previous summary row at the

Description:

grouping level that you specify. For matrix reports, the
summary_field you choose controls whether a
previous row or column is returned. The increment
determines how many steps previous to the current
summary field to return.The default increment is 1.The
maximum increment is 12.

PREVGROUPVAL(summary_field,
grouping_level [, increment]) and replace

Use:

summary_field, grouping_level, and
increment with the expressions you want evaluated.

AMOUNT:SUM - PREVGROUPVAL(AMOUNT:SUM,
CLOSE_DATE)

Example:

This custom summary formula calculates the change
(positive or negative) for a given month compared to the
previous visible month in the report. In this example,
the report is an opportunity matrix grouped by
opportunity close date (in the columns) and stage (in
the rows).

Context Choice in Custom Summary Formula Fields

Previously, a custom summary formula was evaluated in all the contexts within a summary report—at each summary
level, including the grand summary. In Spring '09, you can choose the context in which to evaluate custom summary
formulas. For example, if summarizing an opportunity pipeline report for each month, you can now summarize for all
opportunity stages, without generating a total for all the months.
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For more information, see "Building Custom Summary Formulas" in the Salesforce online help.

Custom Summary Formulas on Matrix Reports

Previously, if there were no records for a particular cell in a matrix report, Salesforce did not evaluate the formula and
displayed an empty cell. In Spring '09, for custom summary formulas on matrix reports, Salesforce calculates formula
results for all cells—even if there are no records to evaluate for that cell. The formula determines the value returned. If
the formula encounters an error, such as division by zero, it returns #Error!. If null is returned, the cell will be empty.

Note:  Custom summary formulas that relied on the fact that cells with no records did not get evaluated may
see errors with this new behavior. Check to make sure your formulas do not contain potential error conditions,
such as division by zero.

For more information, see "Building Custom Summary Formulas" in the Salesforce online help.

Easier Access to Dashboards with Dashboard Finder

Previously, when trying to find dashboards while viewing a dashboard from the Dashboards tab, you had to use the
drop-down list. If you had lots of dashboards, this list could be long and difficult to navigate. In Spring '09, a new option
is available that includes a search filter along with the drop-down list, enabling you to quickly find the dashboard you
want.

To find a dashboard, simply start typing its name in the search filter, and all dashboards matching that text are dynamically
displayed in the drop-down list. You can only see dashboards in folders to which you have access. Disable this option if
you want to use a static drop-down list instead. To edit the Use Auto-Complete When Choosing Dashboards

option, which is enabled by default, click Setup ➤ Customize ➤ User Interface.

More Control Over Distribution of Report and Dashboard Emails

Previously, administrators were not able to restrict the distribution of report and dashboard emails to just internal users.
In Spring '09, a new option is available that allows you to control access to report and dashboard emails for portal users.

To edit the Allow Reports and Dashboards to Be Sent to Portal Users option, which is disabled by
default, click Setup ➤ Customize ➤ User Interface. This option is available to Enterprise and Unlimited Edition
organizations that have a Customer Portal or Partner Portal set up. Unless enabled, only internal Salesforce users can
receive reports and dashboard refresh emails; portal users with sharing access through Roles and Subordinates will not
receive emails. If you enable this option, all internal and portal users specified as recipients will receive reports and
dashboards.

Metadata API Enhancements

In Spring '09, two new fields have been added to the reportAggregate component of the Metadata API. For more
information, see Force.com Development as a Service.

Folder Access Enhancement

Previously, folders that were not shared to anyone, including the owner, were inaccessible. In Spring '09, unshared folders
are treated the same as hidden folders, and can be viewed by users who have the "View All Data" permission.
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Critical Updates Console

Available in: All Editions

Salesforce.com periodically releases updates that improve the performance, logic, and usability of Salesforce, but may affect
your existing customizations. When these updates become available, Salesforce lists them at Setup ➤ Critical Updates, sends
a notification email to administrators, and displays a message when administrators click Setup.

To ensure a smooth transition, each update has an opt-in period during which you can manually activate and deactivate the
update an unlimited number of times to evaluate its impact on your organization and modify affected customizations as
necessary.

Spring '09 features two critical updates:

• Workflow Rule and Roll-Up Summary Field Evaluations The Spring '09 Workflow Rule and Roll-Up Summary Field
Evaluations update affects the way Salesforce evaluates workflow rules and roll-up summary fields on objects with Apex
triggers. The update improves the accuracy of your data and prevents the reevaluation of workflow rules in the event of a
recursion. A recursion is a situation in which a part of your custom logic (such as a roll-up summary field or Apex trigger)
causes Salesforce to execute the logic twice when saving a record, often resulting in undesirable behavior. For more
information, see "What is the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations Update?" in the Salesforce
online help.

• New Opportunity Save Behavior The Spring ’09 New Opportunity Save Behavior update affects how Salesforce processes
your organization's custom logic when changes you make to an opportunity product or schedule affect the following
cumulative fields on its parent record. For more information, see "What is the Spring '09 New Opportunity Save Behavior
Update?" in the Salesforce online help.

Implementation Tips

• Each update detail page has an Impact Analysis section that lists customizations in your organization that may be affected
if you activate the update. Review these customizations, and use the information and examples in the online help to
determine if you need to modify your organization's custom logic. Note that the Impact Analysis may not contain all of
the customizations that the update may affect.

• Salesforce.com recommends testing each update by activating it in either your Developer Sandbox or your production
environment during off-peak hours.

• If you do not encounter any issues when you test an update, leave the update activated.
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About Critical Updates

What are Critical Updates?

Available in: All Editions

User Permissions Needed

"View Setup"To view critical updates:

"Modify All Data" and "Customize Application"To activate critical updates:

Salesforce.com periodically releases updates that improve the performance, logic, and usability of Salesforce, but may affect
your existing customizations. When these updates become available, Salesforce lists them at Setup ➤ Critical Updates, sends
a notification email to administrators, and displays a message when administrators click Setup.

To ensure a smooth transition, each update has an opt-in period during which you can manually activate and deactivate the
update an unlimited number of times to evaluate its impact on your organization and modify affected customizations as
necessary. The opt-in period ends on the auto-activation date, at which time Salesforce permanently activates the update.

Caution: Salesforce.com recommends testing each update by activating it in either your Developer Sandbox or your
production environment during off-peak hours.

To manage critical updates, click Setup ➤ Critical Updates. From this page, you can:

• View the summary, status, and auto-activation date for any update that Salesforce has not permanently activated.
• Click Review to view the detail page of any update that Salesforce has not permanently activated. The details include a

list of the customizations in your organization that the update might affect and the activation history, which lists each time
the update was activated and deactivated.

• Click Activate to activate any inactive update.
• Click Deactivate to deactivate any active update that Salesforce has not permanently activated.

Notes on Critical Updates

When working with critical updates, note the following:

• Salesforce analyzes your organization to determine if a critical update potentially affects your customizations. If your
customizations are not affected, Salesforce automatically activates the update in your organization, and the update does
not appear when you click Setup ➤ Critical Updates.

• On the scheduled auto-activation date, Salesforce permanently activates the update. After auto-activation, you cannot
deactivate the update.

• Each update detail page has its own online help topic that contains important information and examples to help you
understand how your customizations might be affected and how you can correct any unintended functionality.

• Salesforce displays a message the first time you access the setup menu after a critical update becomes available.The message
lets choose to have Salesforce display the updates immediately or remind you about the updates later. You can also choose
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to have Salesforce neither display the updates nor remind you. If you choose this option, Salesforce will not display the
message again until another new update is available.

Workflow Rule and Roll-Up Summary Field Evaluations Update

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

The Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update affects the way Salesforce evaluates workflow
rules and roll-up summary fields on objects with Apex triggers. The update improves the accuracy of your data and prevents
the reevaluation of workflow rules in the event of a recursion. A recursion is a situation in which a part of your custom logic
(such as a roll-up summary field or Apex trigger) causes Salesforce to execute the logic twice when saving a record, often
resulting in undesirable behavior.

Implementation Tips

• The Spring ’09 Workflow Rule and Roll-Up Summary Field Evaluations update is automatically and permanently enabled
for all new customers that sign up after the Spring '09 release in February 2009. These customers will not see the update
on the Critical Updates page.

• Starting in March 09, salesforce.com will begin rolling out the Workflow Rule and Roll-Up Summary Field Evaluations
update for existing customers in phases. Once available, the update will be auto-enabled for organizations without affected
customizations. Customers with customizations that may be affected by the update will see the update on the Critical
Updates page. These customers will need to review the update and take the necessary actions in order to enable the update
prior to its auto-activation date.

• If the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update is not activated by default in your
organization, salesforce.com will permanently activate the update on the date specified in the auto-activation column on
the Critical Updates page. Before that time, salesforce.com recommends testing the update by activating it in either your
Developer Sandbox or your production environment during off-peak hours.

• Leave the update activated if it does not cause any unintended behavior.
• Activation of the Workflow Rule and Roll-Up Summary Field Evaluations update affects the behavior of the Salesforce

user interface, API, and desktop clients.

Best Practices

• Organizations that signed up before the Spring ‘09 release and have customizations that may be affected by the update can
activate the update in both their sandbox and production environments after the update becomes available.

• Salesforce.com recommends testing the update by activating it in your sandbox environment prior to activating it in your
production environment.

• Salesforce.com recommends refreshing your sandbox organization prior to activation to ensure that your sandbox and
production organizations have the same customizations.
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About the Workflow Rule and Roll-Up Summary Field Evaluations
Update

What is the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations Update?

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"View Setup"To view the Spring '09 Workflow Rule and Roll-Up Summary
Field Evaluations update:

"Customize Application" and "Modify All Data"To activate the Spring '09 Workflow Rule and Roll-Up
Summary Field Evaluations update:

The Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update affects the way Salesforce evaluates workflow
rules and roll-up summary fields on objects with Apex triggers. The update improves the accuracy of your data and prevents
the reevaluation of workflow rules in the event of a recursion. A recursion is a situation in which a part of your custom logic
(such as a roll-up summary field or Apex trigger) causes Salesforce to execute the logic twice when saving a record, often
resulting in undesirable behavior.

With this update:

• Salesforce evaluates each workflow rule and roll-up summary field only one time when you save a record.
• Roll-up summary fields can invoke Apex triggers and workflow rules on a parent record only one time when you save its

child record.
• Workflow rules always use current field values on a record.

Without this update, Salesforce is susceptible to evaluating the same workflow rule or roll-up summary field multiple times
when you save a record. This can result in duplicate workflow actions on child records, and can cause roll-up summary fields
to run Apex triggers and workflow rules twice on the parent record. In addition, workflow rules may not use current field
values.

Important: Activation of the Workflow Rule and Roll-Up Summary Field Evaluations update affects the behavior
of the Salesforce user interface, API, and desktop clients.

The Spring ’09 Workflow Rule and Roll-Up Summary Field Evaluations update is automatically and permanently enabled
for all new customers that sign up after the Spring '09 release in February 2009. These customers will not see the update on
the Critical Updates page.

Starting in March 09, salesforce.com will begin rolling out the Workflow Rule and Roll-Up Summary Field Evaluations
update for existing customers in phases. Once available, the update will be auto-enabled for organizations without affected
customizations. Customers with customizations that may be affected by the update will see the update on the Critical Updates
page. These customers will need to review the update and take the necessary actions in order to enable the update prior to its
auto-activation date.
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Caution:  For existing customers, the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update
may affect your customizations if you have an Apex trigger with a trigger event of after update, after insert,
after undelete, or before delete that:

• Updates the current record
• Updates any child record of the current record, and the current record has a roll-up summary field
• Updates an unrelated object that has an Apex trigger that causes an update on the current record
• Deletes the current record or updates an unrelated object that has an Apex trigger that deletes the current record

(after update or after insert triggers only)

If your organization has such customizations, read the examples to understand how your customizations might be
affected and how you can correct any unintended functionality.

If the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update is not activated by default in your organization,
salesforce.com will permanently activate the update on the date specified in the auto-activation column on the Critical Updates
page. Before that time, salesforce.com recommends testing the update by activating it in either your Developer Sandbox or
your production environment during off-peak hours. You can activate and deactivate the update an unlimited number of times.
Leave the update activated if it does not cause any unintended behavior.

Activating the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations Update

To activate the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update :

1. Click Setup ➤ Critical Updates.
2. Click Review next to the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update. Salesforce displays

the update detail page and impact analysis, which includes a list of the customizations in your organization that the update
might affect.

Caution: The impact analysis may not include all of the customizations in your organization that the update might
affect.

3. Review your customizations to see whether the update causes any unintended behavior.

Tip:  Read the examples below to understand how your customizations might be affected and how you can correct
any unintended functionality. If the update will cause unintended behavior, modify the customization before
activating the update.

4. Click Activate.
5. Optionally, enter comments about this activation. For example, if your organization has multiple administrators, you can

explain which of the customizations you reviewed before activating the update. The comments appear in the activation
history.

6. Click Activate.

Deactivating the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations Update

To deactivate the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update :

1. If you created any cross-object field update workflow actions after activating the Spring '09 Workflow Rule and Roll-Up
Summary Field Evaluations update, delete those field updates. A cross-object field update is a workflow action that can
update a value on the record of a related object. Cross-object field updates cannot exists in your system without the Spring
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'09 Workflow Rule and Roll-Up Summary Field Evaluations update. For more information, see "Managing Field Updates"
in the Salesforce online help.

2. Click Setup ➤ Critical Updates.
3. Click Review next to the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update. Salesforce displays

the update detail page.
4. Click Deactivate.
5. Optionally, enter comments about this deactivation. For example, you can explain why you are deactivating the update

and list any unintended behavior the update causes. The comments appear in the activation history.
6. Click Deactivate.

Examples

To understand how the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update might affect your
organization, consider a situation in which you have the following customizations:

• An Apex post trigger on accounts with a trigger event of after update, after insert, after undelete, or before
delete that creates an opportunity when you modify an account with an annual revenue greater than $1,000,000

• A workflow rule on accounts that assigns a task to the account's owner when you modify an account that has an annual
revenue greater than $1,000,000

• A roll-up summary field on accounts that shows the number of opportunities associated with the account

If the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update is not activated and you create or modify
an account that has an annual revenue greater than $1,000,000, the following events happen when you save your changes:

1. The Apex post trigger creates an opportunity.
2. The new opportunity causes the roll-up summary field on the account to increment.
3. The workflow rule assigns a task to the account's owner.
4. Salesforce interprets the change to the roll-up summary field as an additional modification to the account and reevaluates

the workflow rule, resulting in a duplicate task assigned to the account's owner.

If the Spring '09 Workflow Rule and Roll-Up Summary Field Evaluations update is activated and you modify an account that
has an annual revenue greater than $1,000,000:

1. The Apex post trigger creates an opportunity.
2. The roll-up summary field on the account increments.
3. The workflow rule assigns a task to the account's owner.
4. Salesforce recognizes that the workflow rule was already evaluated and does not reevaluate it. No duplicate tasks are assigned

and no duplicate notifications are sent to the account's owner.

Force.com Sites Enhancements

Available in: Developer Edition

Note: Force.com Sites is currently available as Developer Preview. For information on enabling Force.com Sites, go
to http://developer.force.com/iwantsites.
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Force.com Sites enables you to create public websites and applications that are directly integrated with your Salesforce
organization—without requiring users to log in with a username and password.

Spring '09 provides several enhancements to Force.com Sites:

Sites Partner Portal Support

In Spring '09, a Partner Portal can be associated with your Force.com site. Partner Portals can be enabled for login from
your public site; however, they do not support self-registration. For self-registration, use a Customer Portal.

For more information, see "Associating a Portal with Force.com Sites" in the Salesforce online help.

Sites Robots.txt and Favicon Support

In Spring '09, you can customize the favicon.ico and robots.txt files through the user interface.

The robots.txt file determines which parts of your public site Web spiders and other Web robots can access. You can
set this here or by using the Metadata API. HTML tags are not allowed in the file, as they are not compatible with
robots.txt spiders. For Visualforce pages, add contentType="text/plain" to the <apex:page> tag.

The favorites icon is the one that appears in the browser's address field when visiting the site. Use this field to set the
favorites icon for your entire site instead of for each page. Changes will be reflected on your site one day after you make
them, due to caching.

New Sites Audit Trail

In Spring '09, configuration changes to your site are tracked in the new Site History related list.

The Site History related list tracks the following events, along with the user who made the change and the time it
occurred:

DescriptionEvent

Logs when each site was created.Site Creation

Changes to the following site values are logged:Site Detail Changes
• Site Label
• Site Name
• Site Description
• Site Contact
• Default Web Address
• Custom Web Address
• Active Status
• Active Site Home Page
• Inactive Site Home Page
• Site Template
• Site Robots.txt
• Site Favorite Icon
• Enable Feeds

Logs when any standard page is enabled or disabled.Site Standard Pages

Logs when any error page assignment is changed.Site Error Pages
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DescriptionEvent

Changes to the following login settings are logged:Login Settings Changes
• Portal
• Change Password Page
• Require Non-Secure Connections (HTTP)

For more information, see "Viewing Force.com Site History" in the Salesforce online help.

New Sites Standard Pages Related List

In Spring '09, several default standard pages are provided for use out-of-the-box. If you prefer to use Visualforce pages,
you can hide all standard pages from view.

To control which standard pages users see for your site:

1. Click Setup ➤ Develop ➤ Sites.
2. Click the name of the site you want to view.
3. Click Edit on the Site Standard Pages related list.
4. Use the Add and Remove buttons to enable or disable the following standard pages for your site:

• Home Page—The standard page associated with the Home tab (/home/home.jsp).
• Ideas Pages—The standard pages associated with Salesforce CRM Ideas. If you want to use default Ideas pages

(for example, IdeasHome), enable these pages.
• Search Pages—The standard Salesforce search pages. To allow public users to perform standard searches, enable

these pages.
• Lookup Pages—The standard Salesforce lookup pages. These are the popup windows associated with lookup

fields on Visualforce pages.

5. Click Save.

Note:  Make sure to disable any pages that you are not actively using in your site. Otherwise, they may be
accessible to public users. Also, make sure to set up private sharing to restrict search and lookup access for public
users.

New Sites Packaging

In Spring '09, you can package sample code, Visualforce pages, Apex classes, or components for a Force.com site using
a managed package. Force.com sites themselves are not packageable.

Metadata API Enhancements

In Spring '09, four new fields have been added to the customSite component of the Metadata API. For more
information, see Force.com Development as a Service.

Bandwidth Limit Exceeded, Maintenance, and Inactive Home Page Restrictions

In Spring '09, page views and bandwidth will not be counted against the Bandwidth Limit Exceeded Page, the
Maintenance Page, and the designated Inactive Home page. You can use static resources to brand these pages, but the
following limits apply

• Static resources must be 50 KB or smaller in size.
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• Static resources must be stylesheets (CSS), image files, or javascript files.
• You cannot use Apex controllers for these pages.
• You cannot perform SOQL or DML operations from these pages.

Implementation Tips

• Force.com Sites is also available as part of a limited pilot program in Enterprise and Unlimited Editions. For more
information, contact salesforce.com.

• For security purposes, Force.com Sites enforces the following maximum daily limits:

Service Request Time (per day)Bandwidth Limit (per day)Organization Type

10 minutes500 MBDeveloper Edition Organizations

30 minutes1 GBDeveloper Sandboxes

60 hours40 GBProduction Organizations

Bandwidth is calculated as the number of bytes served and received from the site. Service request time is calculated as total
server time required to generate pages for the site.

• Force.com Sites does not support the use of Person Accounts for self registration.
• Force.com Sites is not packageable. However, you can package sample code, Visualforce pages, Apex classes, or components

for a site using a managed package.
• If the Require Secure Connections (HTTPS) checkbox on the Session Settings page is selected, and the Require

Non-Secure Connections (HTTP) checkbox on the Login Settings page is not selected, users logging in to the associated
portal from the Force.com site will see the secure.force.com domain. For example, if you registered mycompany.force.com
as your custom domain, the URL changes to https://mycompany.secure.force.com upon login.

• The construction of the secure URLs for your Force.com sites depends on the type of organization they are built on. In
the following examples, the domain prefix is "mycompany," the sandbox name is "mysandbox," the instance name is "na1,"
and the sandbox instance name is "cs1 ":

Secure URLOrganization Type

https://mycompany-developer-edition.na1.force.comDeveloper Edition

https://mycompany.mysandbox.cs1.force.comDeveloper Sandbox

https://mycompany.secure.force.comProduction

The domain prefix for Developer Edition must contain 22 characters or fewer. The secure URL is displayed on the Login
Settings page.

Best Practices

• Salesforce.com recommends setting the sharing to private for the objects on which you grant "Read" access for your
Force.com site. This ensures that users accessing your site can view and edit only the data related to your site.

• Salesforce.com also recommends securing the visibility of all list views. Set the visibility of your list views to Visible to
certain groups of users, and specify the groups to share to. List views whose visibility is set to Visible to all
users may be visible to public users of your Force.com site. To share a list view with public users, create a new public
group for those users and give them visibility. If the object's sharing is set to private, public users will not be able to see
those records, regardless of list view visibility.
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• If you select a Visualforce page for any of the lookup fields on the Site Detail page, any of the error pages, or the Change
Password Page under login settings, that page is automatically enabled for your site. If you remove a page from this list,
but it is still selected in one of these places, public users can access that page. To completely remove pages from your site,
disable them here and make sure they are not selected in any lookup fields for your site.

• Be careful not to expose any information that you do not want to make public.

About Force.com Sites Enhancements

Associating a Portal with Force.com Sites

Available in: Developer Edition

User Permissions Needed

"Customize Application"To create and edit Force.com Sites:

Note: Force.com Sites is currently available as Developer Preview. For information on enabling Force.com Sites, go
to http://developer.force.com/iwantsites.

You can enable users to register for or log in to an associated portal seamlessly from your Force.com site.

Note:  Only Customer Portals can be used for self-registration. Partner Portals do not support self-registration.

1. Enable the portal for login using the following steps:

a. Click Setup ➤ Customize ➤ Customer Portal ➤ Settings, or click Setup ➤ Customize ➤ Partners ➤ Settings.
b. If you have not enabled your portal, select Enable Customer Portal or Enable Partner Relationship

Management and click Save.
c. Click Edit for the portal you want to modify.
d. Configure the portal as follows:

a. Select the Login Enabled checkbox.
b. Select a user for the Administrator field.
c. Optionally, set the Logout URL. If this is not set, users are taken to the site home page on logout.
d. Click Save.

2. If you are using a Customer Portal and want to allow self-registration, follow these steps:

a. Click Setup ➤ Customize ➤ Customer Portal ➤ Settings.
b. Click Edit for the portal you want to associate with your Force.com site.
c. Configure the Customer Portal as follows:

a. Select Self-Registration Enabled.
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b. Select Customer Portal User for both the Default New User License and Default New User Profile

fields. Depending on your portal license, you may want to select a different profile for the Default New User

Profile field.
c. Select User for the Default New User Role field.
d. Click Save.

3. Associate the site pages with the default portal users using the following steps:

a. Click Setup ➤ Customize ➤ Customer Portal ➤ Settings, or click Setup ➤ Customize ➤ Partners ➤ Settings.
b. Click the name of the portal that you want to associate with your site.
c. Click the name of each profile associated with your portal users and do the following:

a. Scroll down to the Enabled Visualforce Page Access section and click Edit.
b. Add the appropriate public site pages to the Enabled Visualforce Pages list. This allows portal users with

that profile to view these pages.

Note:  By default, portal users can see all pages enabled for the associated public site, so you only have to
enable the pages that require authentication.

c. Click Save.

4. Associate your site with the login-enabled portal using the following steps:

a. Click Setup ➤ Develop ➤ Sites.
b. Click the site label of the site you want to configure.
c. Click Login Settings.
d. Click Edit.
e. From the Enable Login For drop-down list, select the name of the portal for which you want to allow login.
f. Select the Change Password Page.
g. Click Save.

For more information, see Managing Force.com Site Login and Registration Settings.

Note:  For Salesforce CRM Ideas sites, you must associate the community with a portal and enable the IdeasHome
page for the site. Ideas will not be visible to the public until a portal has been associated with that community. To do
this, use the following steps:

1. Click Setup ➤ Customize ➤ Ideas ➤ Communities.
2. Click Edit next to the community you want to make public.
3. From the Portal drop-down list, select the portal to use for this community. You can choose to show the community

in all portals.
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Creating and Editing Force.com Sites

Available in: Developer Edition

User Permissions Needed

"Customize Application"To create and edit Force.com Sites:

Force.com Sites enables you to create public websites and applications that are directly integrated with your Salesforce
organization—without requiring users to log in with a username and password.

Note: Force.com Sites is currently available as Developer Preview. For information on enabling Force.com Sites, go
to http://developer.force.com/iwantsites.

After registering your Force.com domain, create Force.com sites using the following steps:

1. Click Setup ➤ Develop ➤ Sites.
2. Click New.
3. On the Site Edit page, define the following:

DescriptionField

The name of the site as it appears in the user interface.Site Label

The name used when referencing the site in the Force.com
Web Services API. This name must only contain
alphanumeric characters and cannot contain any spaces.

Site Name

An optional description of the site.Site Description

The user who will receive site-related communications from
the site's visitors and salesforce.com.

Site Contact

The unique Force.com URL for this site. Force.com provides
the first part of the URL based on the domain name that

Default Web Address

you registered; you must add a unique site name to the end.
Unless you configure a custom Web address through a
domain name registrar, this is the URL that the public will
use to access your site.

The optional branded top-level domain name that you
registered with a third-party domain name registrar. The

Custom Web Address

custom Web address acts as an alias to your Force.com
address.To enable a custom Web address, create a CNAME
record with that registrar. If you have not registered this
address with a registrar, entering a value in this field has no
effect. Custom Web addresses are not available in Developer
Edition or Developer Sandboxes.
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DescriptionField

Note: If you choose to create a branded top-level
domain or subdomain through a domain name
registrar, the CNAME record that you provide to
that registrar must be your Force.com domain name
and not the site URL. For example, if you entered
"mycompany" when registering your Force.com
domain, the CNAME must be
mycompany.force.com, not the full value of the site
URL.

The option that activates your site when you are ready to
make it available to the public. You can also activate your

Active

site from the Sites and Site Details pages. When the site is
inactive, users will see the page specified in the Inactive
Site Home Page field.

The landing page that users are directed to when this site is
active. Use the lookup field to find and select the Visualforce

Active Site Home Page

page that you developed for your site's home page. Choose
the UnderConstruction page if you just want to test your
site.

Note:  For Salesforce CRM Ideas sites, you must
use the IdeasHome page. The "look and feel" for
your Salesforce CRM Ideas site will be inherited
from its associated portal, unless you select a site
template.

The landing page that users are directed to when this site is
inactive. Use the lookup field to find and select the page that

Inactive Site Home Page

you want to use. You can, for example, select a page to
indicate that the site is under construction or down for
maintenance.

The template that provides the page layout and stylesheet
for your site. The site template overrides any formatting

Site Template

inherited from the associated portal. Use the lookup field to
find and select a template that you've developed, or use the
out-of-box template provided.

Note: The site template specified here is used only
for Visualforce pages using the $Site.Template
expression.

A file that determines which parts of your public site Web
spiders and other Web robots can access. Web robots are

Site Robots.txt

often used by search engines to categorize and archive
websites. HTML tags are not allowed, as they are not
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DescriptionField

compatible with robots.txt spiders. For Visualforce pages,
add contentType="text/plain" to the
<apex:page> tag.

Example disallowing all robots from indexing all pages:

<apex:page contentType="text/plain">
User-agent: * # Applies to all robots
Disallow: / # Disallow indexing of all
pages
</apex:page>

Example allowing all robots to index all pages:

<apex:page contentType="text/plain">
User-agent: * # Applies to all robots
Disallow: # Allow indexing of all
pages
</apex:page>

The icon that appears in the browser's address field when
visiting the site. Use this field to set the favorite icon for

Site Favorite Icon

your entire site instead of for each page. Changes will be
reflected on your site one day after you make them, due to
caching.

The option that displays the Syndication Feeds related list,
where you can create and manage syndication feeds for users

Enable Feeds

on your public sites. This field is visible only if you have the
feature enabled for your organization. For more information,
see "About Syndication Feeds" in the Salesforce online help.

4. Click Save.

Viewing Force.com Site History

Available in: Developer Edition

User Permissions Needed

"Customize Application"To create and edit Force.com Sites:

Note: Force.com Sites is currently available as Developer Preview. For information on enabling Force.com Sites, go
to http://developer.force.com/iwantsites.

To view the site history:
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1. Click Setup ➤ Develop ➤ Sites.
2. Click the name of the site you want to modify.
3. View the Site History related list.

The Site History related list tracks and displays the changes made to your site. All of the following events are tracked in the
site history, along with the user who made the change and the time it occurred:

DescriptionEvent

Logs when each site was created.Site Creation

Changes to the following site values are logged:Site Detail Changes
• Site Label
• Site Name
• Site Description
• Site Contact
• Default Web Address
• Custom Web Address
• Active Status
• Active Site Home Page
• Inactive Site Home Page
• Site Template
• Site Robots.txt
• Site Favorite Icon
• Enable Feeds

Logs when any standard page is enabled or disabled.Site Standard Pages

Logs when any error page assignment is changed.Site Error Pages

Changes to the following login settings are logged:Login Settings Changes
• Portal
• Change Password Page
• Require Non-Secure Connections (HTTP)
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Managing Force.com Site Standard Pages

Available in: Developer Edition

User Permissions Needed

"Customize Application"To create and edit Force.com Sites:

Note: Force.com Sites is currently available as Developer Preview. For information on enabling Force.com Sites, go
to http://developer.force.com/iwantsites.

Force.com Sites uses Visualforce pages for all site and error pages. Force.com also provides some standard pages that you can
use.

All pages that you want to expose on a site must be enabled for that site. If a page is not listed under Site Standard Pages,
Salesforce displays an authorization required error.

To control which standard pages users see for your site:

1. Click Setup ➤ Develop ➤ Sites.
2. Click the name of the site you want to view.
3. Click Edit on the Site Standard Pages related list.
4. Use the Add and Remove buttons to enable or disable the following standard pages for your site:

• Home Page—The standard page associated with the Home tab (/home/home.jsp).
• Ideas Pages—The standard pages associated with Salesforce CRM Ideas. If you want to use default Ideas pages (for

example, IdeasHome), enable these pages.
• Search Pages—The standard Salesforce search pages. To allow public users to perform standard searches, enable these

pages.
• Lookup Pages—The standard Salesforce lookup pages. These are the popup windows associated with lookup fields on

Visualforce pages.

5. Click Save.

Note:  Make sure to disable any pages that you are not actively using in your site. Otherwise, they may be accessible
to public users. Also, make sure to set up private sharing to restrict search and lookup access for public users.

Visualforce Enhancements

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Custom controllers and standard controller extensions are not supported in Group or Professional Editions.

Spring '09 introduces several new features that enhance the capabilities of previous versions of Visualforce. For detailed
information on these new features, see the Visualforce Developer's Guide.
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The following enhancements are now available:

New Controllers (Limited Release)

Spring '09 includes two new controllers that are in limited release. To use these new controllers, please contact your
salesforce.com representative and request that the Salesforce CRM Ideas extended standard controllers be enabled for
your organization. The new controllers are:

• IdeaStandardController — This controller supports all the methods provided in the
StandardController, but also includes the new getCommentList method that returns a list of read-only
comments from the current page.

• IdeaStandardSetController — This controller supports all the methods provided in the
StandardSetController, but also includes the new getIdeaList method that returns a list of read-only
ideas from the current page set. When you use this controller with the ideas:listOutputLink component,
you can specify the sort order, category, status, and community of the returned ideas.

New Components (Limited Release)

Spring '09 includes three new components designed to be used with the new methods available in the
IdeaStandardController and IdeaStandardSetController.To use these new components, please contact
your salesforce.com representative and request that the Salesforce CRM Ideas extended standard controllers be enabled
for your organization. The new components are:

• ideas:detailOutputLink — Use this component with the getCommentList method in the
IdeaStandardController to link to a page displaying an idea and its comments.

• ideas:listOutputLink — Use this component with the getIdeaList method in the
IdeaStandardSetController to link to a page displaying a list of ideas.

• ideas:profileListOutputlink — Use this component with the getIdeaList method in the
IdeaStandardSetController to link to a page displaying a user's profile.

Self-Closing Tags

Beginning with Spring '09, the following Visualforce components are self-closing:

• apex:actionFunction

• apex:actionPoller

• apex:actionSupport

• apex:attribute

• apex:column

• apex:commandButton

• apex:commandLink

• apex:detail

• apex:enhancedList

• apex:flash

• apex:iframe

• apex:image

• apex:include

• apex:includeScript

• apex:inputCheckbox

• apex:inputField
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• apex:inputFile

• apex:inputHidden

• apex:inputSecret

• apex:inputText

• apex:inputTextarea

• apex:listViews

• apex:message

• apex:messages

• apex:outputField

• apex:pageMessage

• apex:pageMessages

• apex:param

• apex:relatedList

• apex:scontrol

• apex:sectionHeader

• apex:stylesheet

• apex:variable

New button overrides have access to record information from the controller.

An override for the New button on an object will now have access to the record information via the standard controller.
This information is useful when used from a related list for that object or when you are trying to find the record type of
the record.

For example, create a page with the following markup:

<apex:page standardController="Contact">
<apex:form >

<apex:pageBlock >
<apex:pageBlockSection >

<apex:inputField value="{!contact.accountid}"/>
</apex:pageBlockSection>

</apex:pageBlock>
</apex:form>

</apex:page>

and then override the New button on Contact to use this page. Visit an account detail page, then click New on the
contacts related list. The value for the inputField will be pre-populated with the account you were visiting.

To see the record type when creating a new contact, create a page with the following markup:

<apex:page standardController="contact">{!contact.recordTypeId}</apex:page>

and then override the New button on Contact to use this page. When you click the New button to create a new contact,
the record type ID will be displayed. Note that this example only makes sense if you have more than one record type for
Contact.

Determine the size of a collection using expression language

You can use expression language to display the size of an Apex collection. For example, if you have the following property:

String[] mycollection = new String[]{ 'One', 'Two', 'Three' };
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the expression {!mycollection.size} will return 3. This value is equivalent to the mycollection.size()
method in Apex.

Force.com Apex Code Enhancements

Available in: Unlimited, Developer, and Enterprise Editions

Force.com Apex code includes the following enhancements in Spring '09. Refer to the Apex Language Reference for complete
information about Apex.

The following enhancements are generally available:

Bind variables now supported in dynamic SOQL and SOSL

As of Spring '09, bind variables are supported for all dynamic queries.

Assignment Rule and Email Notification Support

The Database.DMLOptions object provides the ability to trigger assignment rules and email notifications within Apex.

For more information, see Database.DMLOptions Methods.

Outbound Integration Enhancement: Callout Timeout

An Apex script can make a callout to an HTTP request or a Web services call. Previously, a single Apex transaction
could make 10 calls, each with a maximum timeout of 10 seconds. In Spring '09, the limits are more flexible to support
scenarios that require longer timeouts.

• A single Apex transaction can make a maximum of 10 callouts to an HTTP request or an API call.
• The total request time for one callout cannot exceed 60 seconds.
• The maximum cumulative timeout for callouts by a single Apex transaction is 120 seconds. This time is additive

across all callouts invoked by the Apex transaction.
• A custom timeout of anywhere between 1 millisecond and 60 seconds can be defined for each callout.

Outbound Integration Enhancement: Changes for Classes Defined from WSDL

The following WSDL features are supported for code saved using API version 15.0 and later:

• all

• annotation

• attribute

• choice

• ref

The following schema types are now supported for code saved using API version 15.0 and later:

• xsd:anyURI

• xsd:integer

• xsd:language

• xsd:Name

• xsd:NCName
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• xsd:NMTOKEN

• xsd:NMTOKENS

• xsd:normalizedString

• xsd:token

• xsd:unsignedLong

• xsd:unsignedShort

• xsd:nonPostiveInteger

• xsd:positiveInteger

• xsd:short

Note: The Salesforce dataype anyType is not supported in WSDLs used to generate Apex code that is saved
using API version 15.0 and later. For code saved using API version 14.0 and earlier, anyType is mapped to
String.

Annotation Limit Made Explicit

Methods with the future annotation cannot be used in Visualforce controllers in either getMethodName or
setMethodName methods, nor in the constructor. If you put future in any of these places, an error is returned.
Previously, this would fail without an error.

API Access Change for Dynamic Apex Scripts

Prior to Spring '09, when the API Access for a package was set to Unrestricted, dynamic Apex scripts only had access
to the custom objects contained in that package. Now, when API Access for a package is set to Unrestricted, dynamic
Apex scripts have access to the custom objects contained in the package as well as all standard and custom objects in the
subscriber's organization.

New Classes for Salesforce CRM Ideas

The following classes are now included in the Spring '09 release:

• IdeaStandardController, which extends the functionality of StandardController by including the new
getCommentList method.

• IdeaStandardSetController, which extends the functionality of StandardSetController by including the new
getIdeaList method.

For more information, see IdeaStandardController Class and IdeaStandardSetController Class.

New Exception for SOSL Queries

As of Spring '09, when a SOSL query is executed with the Force.com Web services API search() call and contains
less than two characters, SearchException is thrown.
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Force.com Web Services API Enhancements

Available in: Enterprise, Unlimited, and Developer Editions

The Force.com Web Services API version 15.0 contains new features and bug fixes that improve the capabilities of applications
that leverage the Force.com platform. Considerable effort has been made to ensure backwards capability for applications that
have been written against previous versions of the API, starting with API 2.5.

Note: The older XML-RPC API remains unchanged with this release.

The new API provides a number of powerful enhancements that further improve any integration already in place between
Salesforce and your other systems.

After the Spring '09 release, the 14.0 version of the WSDL file is no longer available. Instead, all requests for a WSDL return
a 15.0 version. Please remember to save WSDL files with your project, as the enterprise WSDL is custom to your organization.
Salesforce maintains backwards compatibility with previous versions of our API in accordance with our stated support policy.
We recommend that developers migrate to the latest version of the API as often as is feasible in order to receive the benefit
of new enhancements from release to release. Developers with integrations on API versions prior to version 2.5 should plan
to migrate to the most recent API in preparation for the eventual end of support for the older API versions.

Generally Available Enhancements

The Force.com Web Services API has been improved for Spring '09:

Platform Changes

• Beginning with API version 15.0, if a value specified for a string or textarea field is too long, an error occurs
and the operation fails. In previous versions, the value is truncated and the operation succeeds. For version 15.0 and
later, if you wish to retain the behavior of versions 14.0 and earlier, you can use the new SOAP header
AllowFieldTruncation.

Note: Truncation behavior for analytic snapshots is unaffected by this change. If a value from a target object
is too large for the source report field, it will be truncated and the snapshot run is not affected.

• Data Replication Enhancement: Beginning with API version 15.0, many objects now support replication
(getDeleted() and getUpdated()). For more information, see the Changed Objects section below.

• When performing a SOSL search on an Idea object, IdeaComment objects are also returned. Similarly, when searching
IdeaComment objects, Idea objects are also returned.

• Beginning with API version 15.0, the ConnectionSentID field on Account, Contact, Lead, Opportunity,
OpportunityLineItem, Product2, and Task objects is no longer supported.The ConnectionSentID field is available,
but the value is null. Use the new PartnerNetworkRecordConnection object to forward records to connections.

• The activation of a critical update in your organization implements the same behavioral changes in the Salesforce
app and the API regardless of the API version you are using. For more information about critical updates, see Critical
Updates Console in “Salesforce Spring '09 Release Notes.”

New Objects

The following new objects have been added to API version 15.0:
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• Bookmark: Represents a link between opportunities that share common information.
• Holiday: Represents a period of time during which your customer support team is unavailable. Business hours and

escalation rules associated with business hours are suspended during any holidays with which they are affiliated.
• PartnerNetworkRecordConnection: Represents a record shared between Salesforce organizations using Salesforce

to Salesforce.

Changed Objects

The following objects have been changed in API version 15.0:

• The ConnectionSentID field on Account, Contact, Lead, Opportunity, OpportunityLineItem, Product2, and
Task is null for API version 15.0 and later. Use the new PartnerNetworkRecordConnection object to forward records
to connections.

• Document has a new field called IsBodySearchable. It indicates whether the contents of a document can be
searched.

• Organization has removed two fields for version 15.0 and later: MaxActionsPerRule and MaxRulesPerEntity.
• The following objects support replication (getDeleted() and getUpdated()):

IdeaCommentCaseTeamMemberAccountOwnerSharingRule

LeadOwnerSharingRuleCaseTeamRoleAccountTerritoryAssignmentRule

MailMergeTemplateCaseTeamTemplateAccountTerritoryAssignmentRuleItem

OpportunityOwnerSharingRuleCaseTeamTemplateMemberAccountTerritorySharingRule

OrderCaseTeamTemplateRecordAddionalNumber

OrderItemCategoryDataApexClass

Organization (getUpdated() only)CategoryNodeApexComponent

ProfileCategoryNodeLocalizationApexPage

RecordTypeContactOwnerSharingRuleApexTrigger

ScontrolCurrencyType (getUpdated()
only)

BrandTemplate

ScontrolLocalizationDivision (getUpdated() only)BusinessHours (getUpdated()
only)

SelfServiceUser (getUpdated()
only)

EmailServicesAddressBusinessProcess (getUpdated()
only)

StaticResourceEmailServicesFunctionCallCenter

VoteEmailTemplateCampaignMemberStatus

WebLinkFolderCampaignOwnerSharingRule

WebLinkLocalizationIdeaCaseOwnerSharingRule

New SOAP Headers
AllowFieldTruncation specifies field truncation behavior in API version 15.0 and later. Beginning with API
version 15.0, if a value specified for a string or textarea field is too long, an error occurs and the operation fails.
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In previous versions, the value is truncated and the operation succeeds. However, if you use this header in version 15.0
and later, the API behaves as it did previously and truncates the fields instead of failing.

API Migration Issues

The following technical notes are available to assist you in migrating from earlier versions:

• Release 4.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-10
• Release 5.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-13
• Release 6.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-15
• Release 7.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-17
• Release 8.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-19
• Release 9.0: http://wiki.apexdevnet.com/index.php/What%27s_New_in_Apex_Web_Services_API_Spring_%2707
• Release 10.0: http://wiki.apexdevnet.com/index.php/What%27s_New_in_Apex_Web_Services_API_Summer_%2707
• Release 11.0: http://wiki.apexdevnet.com/index.php/What%27s_New_in_Force.com_Web_Services_API_Winter_%2708
• Release 12.0:

http://wiki.apexdevnet.com/index.php?title=What%27s_New_in_Force.com_Web_Services_API_Spring_%2708
• Release 13.0: http://wiki.apexdevnet.com/index.php/What%27s_New_in_Force.com_Web_Services_API_Summer_%2708
• Release 14.0 (available after January 14, 2009):

http://www.salesforce.com/us/developer/docs/api140/index_Left.htm#StartTopic=Content/whats_new.htm

Documentation for these earlier versions is also available. See http://wiki.apexdevnet.com/index.php/Earlier_API_Doc on
Developer Force for links to online and PDF versions.

Force.com Office Toolkit Enhancements

Available in: Enterprise, Unlimited, and Developer Editions

The Force.com Office Toolkit version 4.0 contains new features that improve the capabilities of applications that leverage the
Force.com platform.

The new Office Toolkit provides a number of powerful enhancements that further improve any integration already in place
between the Force.com API and Microsoft Office products.

Generally Available Enhancements

The Force.com Office Toolkit has been improved for Spring '09:

New Objects

The following new objects have been added to the Office Toolkit version 4.0:

• MergeRequest8: Represents a structure that is passed as a parameter to merge records of the same object type into
one of the records.

• SforceSessionEvents4: Events raised by the SforceSession4 object
• Tab4: Provides information about the standard and custom tabs available to the logged-in user.
• TabSet4: Provides information about the standard and custom apps available to the logged-in user. An app is a group

of tabs that works as a unit to provide application functionality. For example, two of the standard Salesforce apps are
"Sales" and "Service and Support."
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• TabSetCollection4: This object is a collection of the standard and custom apps in your organization. You can use
the collection to get information about the apps available to the logged-in user.

• UserInfoResult8: Contains the personal information about the currently logged-in user. This information includes
common profile data that your client application can use for display purposes, performing currency calculations, and
so on.

Changed Objects

The following COM objects have changed in the Office Toolkit version 4.0:

• ChildRelationship3 - This object is now named ChildRelationship4.
• Field3 -This object is now named Field4.It contains the following new properties and functions:

- CalculatedFormula
- CaseSensitive
- ControllerName
- DefaultValueFormula
- DependentFields
- ExternalId
- GetDependentPicklistValues
- HtmlFormatted
- IsDependentPicklist
- IsMasterPicklist
- NamePointing
- RelationshipName
- Sortable
- Unique

• LocalizationContext3 - This object is now named LocalizationContext4.
• PicklistValue3 - This object is now named PicklistValue4. It contains the following new property: ValidFor.
• QueryResultSet3 - This object is now named QueryResultSet4. It contains the following new properties:

- LastConfigChange
- Removed
- Token

• SforceSession3 - This object is now named SforceSession4.

It includes the following new properties and functions:

- CurrentUserInfo
- DoLookupSearch
- DoTZConversions
- EarliestStartDateAvailable
- GetOfflineData
- GetTabSets
- LatestDateAvailable
- MakeHTTPRequest
- Mobile
- QueryAll
- OnAckOfflineDataFinished
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- OnGetOfflineDataFinished
- Undelete
- Upsert
- UseCache
- AckOfflineData
- DescribeSObjects

• SObject3 - This object is now named is now named SObject4. It includes the following new properties and functions:

- CreatedByUpsert
- GetJoinResults
- Mergeable
- Retrievable

New Calls

The following calls are now supported in Office Toolkit version 4.0.

• DescribeGlobal()
• DescribeSObject()
• DescribeSObjects()
• DescribeTabs()
• GetServerTimestamp()
• GetUserInfo()
• ResetPassword()
• SetPassword()

Removed Calls

The following calls are no longer supported in the Office Toolkit version 4.0.

• Delete()
• EmptyRecycleBin()
• InvalidateSessions()
• Logout()
• Merge()
• Process()
• QueryAll()

Force.com Development as a Service
Force.com Development as a Service (DaaS) provides the tools and technologies used by professional developers who build
applications for the Force.com platform, as well as those who migrate application changes between development organizations
and production. The DaaS feature area includes support for creating, retrieving, and deploying changes to your organization's
metadata.

New Components

The following metadata component types are new in API version 15.0:
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DescriptionMetadata Component

This component represents a Partner Portal or Customer Portal. To use this metadata
component, you must have a Partner Portal or Customer Portal enabled for your organization.

Portal

Updated Components

The following metadata fields have been added or changed in API version 15.0:

DescriptionChangeFieldMetadata Component

Indicates whether the custom object is
enabled for enhanced lookups (true) or

NewenableEnhancedLookupCustomObject

not (false). Enhanced lookups provide
an updated lookup dialog interface that
gives users the ability to filter, sort, and
page through search results as well as
customize search result columns.

Determines whether or not the standard
home page is visible to public users.

NewallowHomePageCustomSite

Determines whether or not the standard
Salesforce CRM Ideas pages are visible
to public users.

NewallowStandardIdeasPagesCustomSite

Determines whether or not the standard
lookup pages are visible to public users.

NewallowStandardLookupsCustomSite

Determines whether or not the standard
search pages are visible to public users.

NewallowStandardSearchCustomSite

Indicates whether the object referenced
by the object field can be read, edited,

NewmodifyAllRecords (in
ProfileObjectPermissions)

Profile

or deleted by the users assigned to this
profile (true) or not (false), regardless
of the sharing settings for the object.This
is equivalent to the "Modify All Data"
user permission limited to the individual
object level.

Indicates whether the object referenced
by the object field can be read by the

NewviewAllRecords (in
ProfileObjectPermissions)

Profile

users assigned to this profile (true) or
not (false), regardless of the sharing
settings for the object. This is equivalent
to the "View All Data" user permission
limited to the individual object level.

Indicates whether the record type is the
default person account record type for this

NewpersonAccountDefault (in
ProfileRecordTypeVisibility)

Profile

pair of profile and object (true) or not
(false). Only one person account record
type default is allowed per object. This
field is only relevant for record types for
account or contact objects.
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DescriptionChangeFieldMetadata Component

Defines the row grouping level at which
you want your custom summary formula
to be displayed.

NewacrossGroupingContext (in
ReportAggregate)

Report

Defines the column grouping level at
which you want your custom summary
formula to be displayed.

NewdownGroupingContext (in
ReportAggregate)

Report

Additional Force.com Platform Enhancements

Browser Support: Mozilla Firefox 3.0

Available in: All Editions

With Spring '09, Salesforce now supports Mozilla Firefox 3.0.x for the online application.

Package API and Apex Access Setting Enhancements

Available in: All Editions

With Spring ’09, a package developer can now specify API and Apex access settings on objects in a base package. In addition,
an administrator can now manage API and Apex access settings for all standard and custom objects in an installed package.

When a component is included in multiple packages in the same organization, Salesforce resolves to a single API and Apex
access setting for the component. Consider these examples:

• If a developer organization has two packages, one managed and one unmanaged, and both have API and Apex access
settings enabled, the setting on the managed package applies to the component.

• If a component is included in only one unmanaged package with API and Apex access settings enabled, that package’s
settings are enforced.

• If a component is in multiple unmanaged packages but not in a managed package, no API and Apex access settings are
enforced.

Users Appear in Recent Items Lists

Available in: All Editions

As of Spring '09, users are included in the list of most recently used items that appears when performing a standard or enhanced
lookup. Users are also in the recent items list displayed on the sidebar.
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Email Client Enhancements

Available in: Personal, Group, Professional, Enterprise, and Unlimited Editions

Connect for Lotus Notes

• Streamlined the process for associating tasks and events with Salesforce records in Connect for Lotus Notes to make new
users more successful and improve existing users’ productivity.

• Added an always mark for sync feature to improve users' productivity. In Salesforce Options, you can now set Lotus Notes
to automatically mark contacts, tasks, and events for sync when users add new records to their sync folders.

Connect for Outlook

• Streamlined the process for associating tasks and events with Salesforce records in Connect for Outlook to make new users
more successful and improve existing users’ productivity.

• Added an always mark for sync feature to improve users' productivity. In Salesforce Options, you can now set Outlook to
automatically mark contacts, tasks, and events for sync when users add new records to their sync folders.

Offline Enhancements

Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

• Introduced support for person accounts in Connect Offline. Person accounts are accounts for individual consumers with
whom you do business, such as financial services clients, online shoppers, or vacation travelers.

• Updated the Connect Offline SQLite database to Version 3.6.2. This upgrade resolves several buffer overrun and format
string vulnerabilities. The upgrade also fixes a problem involving conflicting date formats and an issue in which newly
created events, opportunities, and tasks appear in the briefcase but not on the home page.

• Introduced support for relationship groups in Connect Offline. Relationship groups are custom object records used to store
collections of accounts. Note that Custom Object related lists on the Relationship Groups detail page are not available in
Connect Offline.

Data Loader Field Truncation

Available in: Enterprise, Unlimited, and Developer Editions

With Spring '09, the Data Loader includes an Allow field truncation checkbox that you can use to truncate data when
you load it into Salesforce.

In Data Loader versions 14.0 and earlier, values are truncated by the Data Loader if they are too large. In Data Loader version
15.0 and later, the load operation fails if a value is specified that is too large. Selecting this option allows you to specify that
the previous behavior, truncation, be used instead of the new behavior in Data Loader versions 15.0 and later.

Email Deliverability and Email Log Access

Available in: All Editions

Spring '09 makes several changes to your email delivery options and provides access to email logs.
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Setup Menu Restructuring
The following options, located under Setup ➤ Email Administration, have been renamed:

• Bounce Administration has been renamed to Deliverability
• Test Email Deliverability has been renamed to Test Deliverability

None of the settings or functionality for these features has changed.

Access to Email Services
The Spring '09 release allows Professional Edition users to create and use email services. For more information, see
What are Email Services?.

Email Security Compliance

You can configure the email you send from Salesforce to automatically comply with email security frameworks such as
SPF and Sender ID.

Many recipient email systems enforce SPF to verify if an email is legitimate. SPF checks the envelope From address of
an inbound email to verify if the email is legitimate. If this feature is enabled, Salesforce modifies the envelope From
address to a salesforce.com email address to verify the legitimacy of the sender. The header From address remains set to
the sender's email address.

Enabling Sender ID compliance will automatically populate the Sender field in the envelope of every email you send
from Salesforce with no-reply@salesforce.com. This enables receiving mail servers using the Sender ID email
authentication protocol to verify the sender of an email by examining the Sender and From headers of an inbound email
through a DNS lookup.

Salesforce.com strongly recommends that you enable both options in order to improve the deliverability of your emails.
For more information, see Configuring Deliverability Settings.

Access to Email Logs

The Spring '09 release provides access to your Salesforce email logs.

Email logs are CSV files that contain information about all email sent and received through Salesforce over the last 30
days. Logs contain data such as:

• The email address of each email sender and recipient
• The date and time each email was sent
• The delivery status of each email
• Any error code associated with each email

You can use email logs to troubleshoot encountered errors.

To request a new email log for your organization:

1. Click Setup ➤ Monitoring ➤ Email Log Files.
2. Click Request an Email Log.

You can have a maximum of three pending log requests at one time. If you already have three pending requests, you
cannot request another log until at least one of those requests completes.

3. Enter a Start Time and End Time range for the email log you want to retrieve. Email logs are available for messages
sent within the past 30 days prior to your request.

Note:  Each email log can span a maximum of seven days. To see email log data from a period of time greater
than seven days, create multiple requests.
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4. Optionally, you can filter an email log to only include rows where a specific domain name or email address appears
in the Recipient or Sender fields. To enter more than one search term, separate each value with a comma. If you
leave this field blank, the log is not filtered and all email addresses are returned within the specified time range.

5. Enter the email addresses that you want to receive notification when the email log request is complete. Separate each
email address with a comma.

For more information, see "Email Logs" in the Salesforce online help.

S-controls and Visualforce

Visualforce pages are considered the next-generation of s-controls and should be used instead of s-controls whenever possible,
both for their increased performance and the ease with which they can be written. In addition, s-controls will be desupported
in a future release. The following table outlines the differences between Visualforce pages and s-controls.

S-ControlsVisualforce Pages

HTML, JavaScript, AJAX ToolkitHTML, XMLRequired technical skills

Procedural codeTag markupLanguage style

Write HTML and JavaScript for entire
page

Assemble standard and custom
components using tags

Page override model

NoYesStandard Salesforce component library

NoYes, through the standard controllerAccess to built-in platform behavior

No

Developers cannot bind an input
component to a particular field. Instead,

Yes

Developers can bind an input component
(such as a text box) with a particular field

Data binding

they must write JavaScript code that uses(such as Account Name). If a user saves
the API to update the database with
user-specified field values.

a value in that input component, it is also
saved in the database.

No, must bring in Salesforce stylesheets
manually

YesStylesheet inheritance

Yes, if coded in JavaScript using a
describe API call

If a user attempts to save a record that
violates uniqueness or requiredness field

Yes, by default

If a user attempts to save a record that
violates uniqueness or requiredness field
attributes, an error message is
automatically displayed and the user can
try again.

Respect for field metadata, such as
uniqueness

attributes, an error message is only
displayed if the s-control developer wrote
code that checked those attributes.

Indirect, by using Apex webService
methods through the API

Direct, by binding to a custom controllerInteraction with Apex

Less responsive because every call to the
API requires a round trip to the

More responsive because markup
executes on platform

Performance

server—the burden rests with the
developer to tune performance

In an iFrameNativePage container
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Additional Language Support

Available in: All Editions

Indonesian Language Support
With Spring '09, Salesforce now supports the Indonesian language. This language is not automatically available. You
must contact your salesforce.com representative to enable this language. In addition, this language is only available as
an end-user language, which means that only the end-user labels are translated.

Additional Language Support for Spell Checker
The following languages are now supported in the spell checker:

• British English
• Canadian English
• Canadian French
• Danish
• Dutch
• Norwegian
• Portuguese
• Finnish

The spell checker is available when sending emails, creating and editing activities, and in other places within the
application.

Salesforce.com Style Guide and Online Help CSS Publicly Available

Available in: All Editions

The Force.com platform already provides you with the ability to create customized help for your organization and the
AppExchange apps you create. To assist you in creating high-quality help documentation, salesforce.com has made its own
online help style guide and CSS style sheets publicly available for your reference.

To give your custom help a professional tone using Salesforce terminology, follow the Salesforce.com Style Guide for
Documentation and User Interface Text. To use the Salesforce styles, reference the Salesforce online help style sheet with a
relative path of /sCSS/Theme2/default/help.css. To learn more about creating customized help, see "About Custom Help"
in the Salesforce online help.

Security Enhancements

Available in: All Editions

Spring '09 includes the following enhancements for security:

Forcing Relogin After Login-As-User Session Ended
There is a new option that determines whether an administrator that is logged in as another user is returned to their
previous session after logging out as the secondary user. If the option is checked, an administrator must log in again to
continue using Salesforce after logging out as the user; otherwise, the administrator is returned to their original session
after logging out as the user. Forcing administrators to log in again is more secure as it avoids scenarios where a user
could take advantage of the login-as capability to escalate their privileges to those of the administrator.
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To force users to log in again after a login-as-user session has ended:

1. Click Setup ➤ Security Controls ➤ Session Settings.
2. Select the Force Relogin After Login-As-User checkbox.
3. Click Save.

Download Zipped Login History
There is a new option to allow users to download a gzipped Excel csv file of login history. This is the preferred option
for quickest download time rather than downloading an uncompressed file.

To download a zipped login history file:

1. Click Setup ➤ Manage Users ➤ Login History.
2. Click the gzipped Excel csv file link.

Workflow and Approvals

Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

Spring '09 provides the following capabilities related to workflow rules and approval processes.

Cross-Object Workflow for Custom Objects
In Spring ’09, you can perform cross-object field updates using workflow rules. For standard objects, workflow rules can
only perform field updates on the object related to the rule. The exceptions are that both Case Comments and Email
Messages can perform cross-object field updates on Cases. For all custom objects, however, you can create workflow
actions where a change to a detail record updates a field on the related master record. Cross-object field updates only
work for master/detail relationships. For example, in a custom recruiting application, create a workflow rule that sets
the status of an application (the master object) to "Closed" when a candidate (the detail object) accepts the job. Or, for
standard objects, create a rule to change the status of a case from "Awaiting Customer Response" to "In Progress" when
a customer adds a case comment.

Workflow and Approval Processes in Professional Edition
In Spring ’09, workflow and approvals are available for Professional Edition for an additional cost. In Professional
Edition, the time-based workflow governor limits are lower than for Enterprise or Unlimited Editions. For more
information, see "Salesforce Editions and Limits" in the Salesforce online help.

Formula Language Enhancements

Available in: All Editions

Spring '09 provides the following enhancements to formulas:

TEXT() Function Support for Picklists in Validation Rules
When creating validation rules, you can now use the TEXT() function to reference picklist values. This allows you to:
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• Use text functions, such as CONTAINS, BEGINS, LEFT, MID, UPPER, and LOWER, on picklist values. For example,
the following formula returns TRUE if the Status picklist contains the value "Closed":

CONTAINS(TEXT(Status)), "Closed")

• Use numeric functions on numeric picklist values. For example, the following formula multiplies the first five numbers
of the Quantity picklist by the Unit numeric field, and returns TRUE if the result is greater than 10,000:

VALUE(LEFT(TEXT(Quantity), 5)) * Unit > 10000

• Directly compare two picklists. For example, the following formula compares the values of the bug_status picklist
with values of the case_status picklist, and returns TRUE if they are equal:

TEXT(bug_status) = TEXT(case_status)

Note: The TEXT() function always returns picklist values in your organization's master language, not the
language of the current user.

Locale Rule Support in the UPPER() and LOWER() Functions for all Formulas
In Spring ’09, Salesforce supports locale rules in the UPPER() and LOWER() functions for all formulas. This allows
you to convert all letters in a value to uppercase or lowercase using the rules of the locale, if provided. The syntax is:

UPPER(text, [locale])

or

LOWER(text, [locale])

For example, the Turkish language has two versions of the letter i: one dotted and one dotless. The locale rules for
Turkish require the ability to capitalize the dotted i, and allow the dotless I to be lowercase.To correctly use the UPPER()
function with the Turkish language locale, use the Turkish locale code tr in the UPPER() function as follows:

UPPER(text, "tr")

This ensures that Salesforce does not transform any dotted i that may be in the text to a dotless I.

Note:  For locale codes, see "What languages does Salesforce support?" in the Salesforce online help. For information
on locale rules, see "Adding and Editing Translated Languages" in the Salesforce online help.
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